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1.

System Overview

Wireless Sensor Network Overview

The LORD MicroStrain ® Wireless Sensor Network is a high- speed, scalable, sensor data
acquisition and sensor networking system. Each system consists of wireless sensor interface
nodes, a data collection gateway, and full-featured user software platforms based on the LORD
MicroStrain® Lossless Extended Range Synchronized (LXRS ® ) data communications protocol.
Bidirectional wireless communication between the node and gateway enables sensor data
collection and configuration from up to two kilometers away. Gateways can be connected locally to
a host computer or remotely via local and mobile networks. Some gateways also feature analog
outputs for porting sensor data directly to standalone data acquisition equipment.

The selection of available nodes allows interface with many types of sensors, including
accelerometers, strain gauges, pressure transducers, load cells, torque and vibration sensors,
magnetometers, 4 to 20mA sensors, thermocouples, RTD sensors, soil moisture and humidity
sensors, inclinometers, and orientation and displacement sensors. Some nodes come with
integrated sensing devices such as accelerometers. System sampling capabilities are IEEE
802.15.4-compliant and include lossless synchronized sampling, continuous and periodic burst
sampling, and data logging. A single gateway can coordinate many nodes of any type, and multiple
gateways can be managed from one computer with the Node Commander ® and SensorCloud™
software platforms. Integration to customer systems can be accomplished using OEM versions of
the sensor nodes and leveraging the LORD MicroStrain® data communications protocol.
Common wireless applications of LORD MicroStrain ® Sensing Systems are strain sensor
measurement, accelerometer platforms, vibration monitoring, energy monitoring, environmental
monitoring, and temperature monitoring.
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2.

Node Overview

Node Overview

The V- Link ® - LXRS ® wireless sensor node features seven analog input channels designed to
accommodate a wide range of Wheatstone bridge and analog sensors including, strain, load cell,
torque, pressure, acceleration, vibration, magnetic field, displacement, and geophones. There are
three channel s for single- ended sensor measurement, four channel s for differential sensor
measurement, and an on-board internal temperature sensor.
V-Link® -LXRS® inputs are 16-bit resolution with ± 0.1% full scale measurement accuracy. The
node can log data to internal memory, transmit real-time synchronized data, and it supports event
driven triggers with both pre- and post- event buffers.
To acquire sensor data, the V-Link -LXRS is used with a LORD MicroStrain data gateway such as
the WSDA®-Base or WSDA® -1500 - LXRS®.

Figure 1 - V-Link®-LXRS® Wireless Sensor Node
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2.1

Node Overview

Components List

V- Link ® - LXRS ® sensor nodes come with the following components and options. For a
complete list of available configurations, accessories, additional system products and ordering
information see Parts and Configurations on page 97.

Item
A
B
C
-E
--

Description
V-Link®-LXRS® Wireless

Sensor Node

1

Antenna with right angle adapter

1

Removable terminal blocks

2

Power supply and plug adapter kit (optional)
Node Tester Board (optional)
User Manual, Quick Start Guide and Calibration Certificate

Table 1 - V-Link®-LXRS® Components List

9

Quantity

1 each
1
1 each
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2.2

Node Overview

Interface and Indicators

The V-Link®-LXRS® includes a power input jack for charging the internal battery or externally
powering the node, a power on/off switch, an antenna connector for attaching the node
antenna, terminal blocks for connecting sensing devices and power, and mounting holes for
device installation.
The indicators on the V-Link ® -LXRS ® include a device status indicator, and a battery charge
status indicator. The following table describes basic indicator behavior. During data acquisition,
the device status indicator has other sequences (see Device Status Indicators on page 83).

Figure 2 - Interface and Indicators

Indicator
Battery charge status
indicator

Device status indicator

Behavior
OFF
ON bright red
ON dim red
ON green
OFF
Rapid flashing on
start-up
1 (slow) pulse per
second

Node Status
Node battery is not currently being charged
Node battery is charging
Battery fault condition. Reset by unplugging power and then
plugging node in again
Battery is fully charged
Node is OFF
Node is booting up
Node is idle and waiting for a command

Table 2 - Indicator Behaviors
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2.3

Node Overview

Node Operational Modes

Sensor nodes have three operational modes: active , sleep , and idle. When the node is
sampling it is in active mode. To stop sampling, the node is put into idle mode. Idle mode is used
for configuring node settings (such as frequency and sampling rates) and is the only way to stop
sampling or go between active and sleep modes. Sleep mode is an ultra low power mode. The
node will automatically go into sleep mode after a user-settable period of inactivity. The node
will not go into sleep mode while sampling.

Figure 3 - Node Operational Modes

11
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3.

System Operational Overview

System Operational Overview
The V- Link ® - LXRS ® contains an internal, rechargeable
Lithium Polymer (Li-Po) battery. For important precautions
see Safety Information on page 107.

The V- Link ® - LXRS ® is susceptible to damage and/or
disruption of normal operation from Electrostatic Discharge
(ESD). For important precautions see Safety Information on
page 107.

To acquire sensor data, nodes are used with any LORD MicroStrain ® data gateway, such as the
WSDA® -Base -10x -LXRS® or WSDA® -1500 - LXRS®, and a software interface.
LORD MicroStrain ® has two software programs available for data acquisition from the wireless
sensor network: SensorCloud™ and Node Commander ® . SensorCloud™ is an optional webbased data collection, visualization, analysis, and remote management platform based on cloud
computing technology. Node Commander® is used for configuring gateways and nodes, selecting
sampling modes and parameters, initializing data acquisition, and viewing and saving data.
The operational overview describes system hardware and software setup, and the basic
navigation of Node Commander® used to configure the node and begin data acquisition. A brief
overview of porting data to SensorCloud™ is also included. This section is included as a quick start
guide and is not a complete demonstration of all system and software capabilities.
l

l
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For an example of sensor configuration and a calibration routine, or for verification of system
functionality, see Using the Node Tester Board on page 84.
For instructions on connecting specific sensors, see Connecting Sensors on page 34.
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System Operational Overview

NOTE
To maximize operating time, it is recommended that the V- Link ® -LXRS ® internal
battery be fully charged before installation. If fully discharged, it can take up to 8
hours. For charging instructions see Charging the Node Battery on page 76.

3.1

Software Installation

To install Node Commander ® Software Suite on the host computer, run the installer
executable file and follow the on-screen prompts. The software is provided with all gateways
and is available on the LORD MicroStrain® website (see References on page 111).

NOTE
The Node Commander ® software includes hardware drivers required for use with
USB gateways. Once installed, the software will automatically detect and configure
any USB gateways that are plugged into the host computer.

The suite includes the following programs:
l

l

l

Node Commander is used for configuring nodes and acquiring, viewing, and
saving data.
Live Connect™ is a TCP/IP-to-serial conversion tool that translates the
communications between Node Commander and an Ethernet gateway.
WSDA® Data Downloader is used to download acquired data from the flash
memory card embedded in an applicable gateway, to a host computer.

SensorCloud™ is an optional data collection, visualization, analysis, and remote
management tool. It is based on cloud computing technology and is accessed directly from a
web connection. Automatic, real- time data collection is available through Ethernet
gateways, such as the WSDA® -1500 - LXRS®. Data files can also be easily uploaded. For
more information see Data Handling on page 26.
Users can also design custom programs with the open source data communications
protocol (see References on page 111).
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3.2

System Operational Overview

System Connections

To acquire sensor data the following components are needed: user-supplied external sensors
(as applicable) , a LORD MicroStrain ® wireless sensor node, a LORD MicroStrain ® data
gateway and a local or networked host computer with access to the data acquisition software
(such as Node Commander ® and SensorCloud™). For a connections overview refer to Figure
4 - System Connections .
Nodes will communicate with any LORD MicroStrain ® data gateway. The sensor, node,
gateway, and software selection are application-dependent, but the basic interfaces are the
same. Communication protocols between the gateway and host computer vary depending on
which model gateway is used, but they all require interface to a host computer or network. The
WSDA® -Base -10x -LXRS ® gateway utilizes local serial connections to the host computer,
such as RS232 and USB, and interfaces with the Node Commander® software. The WSDA® 1500 - LXRS ® gateway utilizes Ethernet communications and can be used with Node
Commander ® and SensorCloud™, although system configuration is completed using Node
Commander® . Gateways with analog outputs can be connected directly to stand-alone data
acquisition devices for data collection, however system configuration will still occur through a
USB interface to Node Commander®.
Users can also write custom programs by utilizing the LORD MicroStrain ® Wireless Sensors
Network Software Development Kit (see References on page 111).

Figure 4 - System Connections
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3.3

System Operational Overview

Gateway USB Communication

The WSDA-Base USB gateway is used as an example in this quick start guide. For information
on how to use other gateways, refer to the gateway or Node Commander ® user manual (see
References on page 111).
Drivers for the USB gateways are included the Node Commander® software installation. With
the software is installed, the USB gateway will be detected automatically whenever the
gateway is plugged in.
1. Power is applied to the gateway through the USB connection. Verify the gateway
status indicator is illuminated, showing the gateway is connected and on.
2. Open the Node Commander software.

3. The gateway should appear in the Controller window automatically with a
communication port assignment (Figure 5 - USB Gateway Communication). If it is not
automatically discovered, verify the port is active on the host computer, and then
remove and re-insert the USB connector.

Figure 5 - USB Gateway Communication
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3.4

System Operational Overview

Connect to Nodes

Several methods can be used in Node Commander® to establish communication with the
nodes. This quick start section covers the two simplest methods; adding a node by address and
by using the node discovery feature.

3.4.1

Adding a Node by Address

Adding a node by address requires the node to be on the same communication frequency
as the gateway. The node address and frequency are indicated in the documentation
included with the node when it is purchased.
1. To add a node by address, right-click on the gateway name in the Controller window,
and select Add Node > Add Single Node (Figure 6 - Adding a Node by Address).
2. The node address and frequency are indicated in the documentation included with
the node. Enter the node address, and select OK. If the node is not found, a message
will appear and provide the option to scan for the node on other frequencies.
Alternately, the Node Discovery feature can be used.

Figure 6 - Adding a Node by Address
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3.4.2

System Operational Overview

Using Node Discovery

The Node Discovery feature allows connection between the gateway and node to occur
even if they are on different frequencies. To connect to nodes using node discovery, begin
by making sure the node is powered off.

NOTE
Automatic node discovery may not work in some boot-up modes. If the node is
not in normal boot up mode, the assigned one can be bypassed to enable node
discovery. For more information see Troubleshooting Guide on page 78.

1. Right-click on the gateway name and select Add Node > Node Discovery (Figure 7 Using Node Discovery).
2. Using the power switch, turn on the node. Within a few seconds, the node will
transmit a message with its operating frequency.
3. When the device status indicator on the node ends the rapid flash sequence and
begins pulsing at one-second intervals, the node has completed the normal boot-up
sequence and is running in idle mode. At this point the node should be listed in the
Controller window; scanning can be stopped by selecting the Stop button in the Node
Discovery window.

Figure 7 - Using Node Discovery
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3.5

System Operational Overview

Channel Configuration

The sensor settings are stored in the node memory, and each sensor is assigned a
corresponding channel number. The configuration menus will only show the channels and
configuration options that are available for the type of node being used.
1. To enter the configuration menu, right-click on the node name, and select Configure >
Configure Node. The Channels tab displays channel options available for the node.
a. Channel Enabled: indicates the sensor channel number. The check box
is used to enable the channel and select it for sampling. The icon next to
the check box describes the channel type inherent to the node being used.
In the following example (Figure 8 - Node Channels Menu): a1) analog
differential channel icon, a2) analog single ended channel icon, and a3)
temperature channel icon.
b. Current channel configuration: The Data Output, Units, Input Range,
and Label fields describe how the channel is currently configured.
c. Configure: The Configure button changes the channel parameters, such
as measurement units, gain and offset settings, and calibration
values. The channel must be enabled first by selecting the adjacent check
box.

Figure 8 - Node Channels Menu
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System Operational Overview

2. To enter the channel configuration menu, select the Configure button as shown in
Figure 8 - Node Channels Menu. The channel configuration menu options change
depending on the sensor type selected.
a. Channel Label: names the channel
b. Channel diagram: shows channel electronics and data flow
c. Conversion Coefficients: defines the type and units of the
measurement being made
d. PGA Settings: These settings determine what gain is applied to the
sensor measurement and set the position of the no- load baseline
measurement for the sensor signal. It is only available for differential input
channels with gain amplifiers.
e. Calibration values: includes the slope, offset, scale, and formula used to
convert the sensor reading to engineering units. The slope and offset can
be determined from the sensor manufacturer calibration data or through a
calibration process.

Figure 9 - Channel Setup
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3.6

System Operational Overview

Sampling Settings

Sampling settings are accessed through the Configure Node menu. There is a tab for each
sampling mode available for the particular node (Figure 10 - Sample Settings Menu).The VLink ® -LXRS ® has four primary sampling modes: Synchronized Sampling, Low Duty Cycle
Sampling, Streaming, and Datalogging. Some modes have user- configurable settings for
sample rate, sample duration, and datalogging. Other settings are automatic, depending on
number of active channels and other variables. For more information on sampling modes, refer
to the Node Commander user manual (see References on page 111).

Figure 10 - Sample Settings Menu
In general, when determining what sample mode and rate is most suitable for the application,
refer to the following guidelines;
l

l

l

Use a sample rate at least twice the value of the target measurement frequency. This is the
minimum sample rate required to produce an accurate digital representation of the
measured signal. The higher the sample rate, the more accurate the digital representation.
Using the minimum required sample rate will increase battery life and minimize the
allocated network bandwidth.
Using periodic burst sampling in place of continuous sampling will increase battery life, and
the longer the sample interval, the more power and network bandwidth will be saved.

For synchronized sampling, use the online calculator to evaluate network bandwidth at different
sampling settings :
http://www.microstrain.com/configure-your-system
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3.7

System Operational Overview

Data Acquisition

When data acquisition is started, each of the sampling modes has different menu options and
views. Some open a settings menu before data acquisition begins and may include a data list
view and/or a graph view. The following is an example of Synchronized Sampling (Figure 11 Starting a Sampling Session). For more information about synchronized sampling and using
the gateway beacon see Data Acquisition on page 21. For more information about other
sampling modes, refer to the Node Commander® user manual. (see References on page 111).
To start a sampling session, nodes can be selected individually or as a group. When selected
as a group, they will all be set to the same sampling mode. Right-click on the nodes and select
Sample > Synchronized Sampling.

Figure 11 - Starting a Sampling Session

When a synchronized sampling session is started, the sampling menu appears and includes
settings to enable optional sampling features, configure nodes, and to specify where the data
will be saved. The built-in bandwidth calculator displays the total bandwidth used by the nodes
selected for synchronized sampling (Figure 12 - Synchronized Sampling Menu).
a. Save Location: indicates where the data file will be saved on the host computer.
Use the Browse button to select a location.
b. Node configuration: includes the node serial number, sampling settings,
bandwidth calculation, and current status. Highlight any node or group of nodes,
and the Remove, Configure, and Refresh buttons become active. The Configure
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System Operational Overview

button opens the node configuration menus to adjust settings as needed and
recalculates the node bandwidth. Multiple nodes can be configured together by
using the Shift or Ctrl key to select them.
c. Lossless: enables the lossless data protocol. The protocol enables buffering and
retransmission of data in order to provide 100% data collection success. Using this
feature may increase data display latency.

Figure 12 - Synchronized Sampling Menu
d. High Capacity: optimizes bandwidth and power use for nodes with slower sample
rates by reducing the transmit rates. May increase data latency.
e. Network Bandwidth: is the total calculated bandwidth used by all the nodes. The
bandwidth changes as nodes are added, removed. and settings changed.
f. Enable Beacon on Start: When synchronized sampling is started the nodes wait
for the first beacon transmission to initiate sampling. When this option is selected
(default), the gateway beacon is enabled and will begin transmitting at a fixed
interval when sampling is started. Disabling the beacon on start (unchecking the
box) will set the nodes to wait for the beacon, but it does not actually start the
beacon when sampling is started. This can be used if there is a need for sampling to
be initiated later, or if the beacon is being received from another source than the
gateway. Enabling the beacon in this way is the same as enabling the beacon in the
gateway menu Refer to the Node Commander® User Manual for more information.
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System Operational Overview

g. Apply settings and start sampling: Before acquisition can begin, use the Apply
Network Settings to save the session settings to the node. When completed, select
Start Sampling to begin.
h. Close sampling window (with the red "X") to exit sampling or, once the sampling
has been started, to view the data window behind it.
Synchronized sampling features two data views: Grid view and Graph view. Once sampling
has started, the data grid view is the default view (Figure 13 - Synchronized Sampling Data
View).

Figure 13 - Synchronized Sampling Data View
a. Device status: Node sampling mode and gateway status are displayed in
parentheses next to the device name.
b. Node information: includes node serial number and sampling statistics. Rightclick on the node name for more menu options such as Stop Nodes.
c. Data: is a display of the sampled data with each channel in its own column.
d. Radio strength: indicates the strength of the communication between the gateway
and node. See Range Test on page 33.
e. Data file: the location and size of the data file, as data is added. View the data in
.CSV format with the Open File button.
f. View menu: Select between Data Grid and Graph views.
g. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.

23

V-Link®-LXRS® Wireless Sensor Node User Manual

System Operational Overview

NOTE
When synchronized sampling is set to slower sample rates it may take several
seconds after sampling is initiated for the first sample to appear.

Use the view menu to select the Graph view of the data (see Synchronized Sampling Graph
View on page 24). Click on the node name to view the graph for that node. Click again to hide it.

Figure 14 - Synchronized Sampling Graph View
a. Available Nodes: Click on the node to display the graph for that node. Click again
to hide it. Right-click on the node name for more menu options such as Stop Nodes
and Save Stream.
b. Axis range: Select the x-axis width and y-axis zoom percentage, or use the Auto
check box for automatic scaling.
c. Graph: The node graph shows the sampled data. Each active channel is displayed
in a different color. The x-axis is time in seconds and the y-axis is the A/D value
(bits). Right-click on the graph for additional menu options such as View Graph Key,
Pan, Zoom, Pause, and Remove Graph.
d. View menu: Select between Data Grid and Graph views.
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System Operational Overview

e. Data file: The location and size of the data file as data is added. View the data in
.CSV format with the Open File button.
f. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.

NOTE
Once sampling has started it will continue as configured without the need to leave
Node Commander ® open. However, if the node is powered off and is not configured
to sample on boot- up, data acquisition will end and must be restarted in Node
Commander®.

25
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3.8

System Operational Overview

Data Handling

Data acquired through Node Commander ® is automatically saved on the host computer (see
Sensor Data Files on page 30) and can also be viewed from the web-based SensorCloud™
portal. Saved data can be uploaded to SensorCloud™ and Ethernet gateways provide the
option to automatically port the data to SensorCloud™ during data acquisition for near realtime display and aggregation. Ethernet gateways can also be configured to save data locally to
internal memory for future upload to the host computer or SensorCloud™.
SensorCloud™ is based on cloud computing technology and is designed for long term
collecting and preservation of data. Features include time series and visualization graphing,
automated alerts, and data interpretation tools such as data filtering, statistical analysis, and
advanced algorithm development with the integrated MathEngine ® interface. Leveraging the
open source API, SensorCloud™ can also be used to collect data from other LORD
MicroStrain ® sensor products or third- party systems. Basic SensorCloud™ services are
available to all users free of charge (see Connecting to SensorCloud™ on page 27).

Figure 15 - Data Storage, Display and Processing
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3.8.1

System Operational Overview

Connecting to SensorCloud™

To connect to SensorCloud go to the SensorCloud website log-in page, and enter the log-in
credentials. Register as a new user if needed.
http://sensorcloud.com/log-in/

Figure 16 - SensorCloud™ Log-in or Register
The SensorCloud interface has six main views. When logging in as a registered user, the
Device view is the default. Navigate to other views by clicking the view name at the top of the
page (Figure 17 - SensorCloud™ Menu Views). The Data and Settings views are only
available once a device is selected from the device list.

Figure 17 - SensorCloud™ Menu Views
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Device - The device list shows every Ethernet gateway and API device associated with the
SensorCloud account, including owned, shared, and demo devices. This view provides links to
each device’s SensorCloud subscription plan, configuration options, and a summary of last
communications and data transactions.
Account - The account view is for logistic management of the SensorCloud account, such as
changing the log-in password, accessing user email, and reviewing billing information.
CSV Uploader - The data upload feature enables data from any source (such as non-Ethernet
LORD MicroStrain gateways, or third- party sensor) to be uploaded to the SensorCloud
platform. The data must be in the LORD MicroStrain CSV format.
Data - This view is only available after a device is selected. It displays data that is collected
from sensor nodes or uploaded from files. Data selections are listed by node channel or a userdefined label, and can be enabled for display in the graph window. The interactive graph has
navigational features such as panning, zooming, and an overview graph for single-click access
to data points or ranges. There are also use and management features such as viewing the
meta-data and downloading, embedding, and tagging data graphs.

Figure 18 - SensorCloud™ Data View
Settings - The settings view provides options for adding meta- data, configuring the data
displays for each channel, creating alerts based on data thresholds, setting the data timezone,
and more.
MathEngine ® - is used to analyze sensor data. Functions include the ability to filter out
frequencies, smooth out noisy data, perform math operations such as Fast Fourier Transforms
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(FFTs), and more ( Figure 19 - MathEngine® View ) . MathEngine ® interfaces with the
SensorCloud graphing view for faster processing. Users can write their own algorithms for
custom applications. Refer to the MathEngine® website for more information.
http://sensorcloud.com/mathengine

Figure 19 - MathEngine® View

Figure 20 - FFT Graph in SensorCloud™
For more information about SensorCloud features and navigation, refer to the SensorCloud
website or contact LORD MicroStrain Technical Support.
http://sensorcloud.com
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Sensor Data Files

Data acquired in Node Commander is stored in .CSV format and can be opened with
Microsoft Excel, Quattro Pro, Open Office, or another CSV editors/spreadsheet program.
Data in this format is easily uploaded to SensorCloud™ using the CSV Uploader. The data
files can be found on the host computer in the default directory or the location specified at
the beginning of the sampling session (as applicable). The files are organized in separate
folders by mode and then further categorized by date, session, and/or node serial number.
The default directory is: C:\ProgramData\Microstrain\NodeCommander\Data
Synchronized sampling and low duty cycle files are found in the Sampled Data folder,
and streaming data is stored in the Streaming folder. Datalogging files need to be
downloaded from the node to be available for viewing. They are accessed through
datalogging menus as well as the File menu, and are saved in the Downloaded Triggers
folder.

Figure 21 - Exploring Data
NOTE
The Microsoft Excel the Time data column in the data file may have to be
changed to "m/d/yyyy h:mm:ss:000" format to make it more readable.
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Node Installation
4.1

Mounting Recommendations

The V-Link®-LXRS® is rated for indoor use only, unless housed in a ruggedized outdoor
enclosure. Enclosures for the V-Link ®-LXRS ® are available from LORD MicroStrain®. Some
also accommodate D cell batteries, extending the battery operating capacity and duration. For
more information see Node Accessories on page 98.
There are two mounting tabs on the node, with holes for fastening. The terminal blocks must
be removed to insert the mounting hardware.
The node can be mounted in any orientation, but it is recommended that it is mounted in a way
that optimizes wireless communications, typically with the antenna pointing upward. . For more
information see Optimizing the Radio Link on page 32.

Figure 22 - Mounting the Node
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Optimizing the Radio Link

In ideal conditions, the nodes and gateway can communicate up to two kilometers apart. In
order to accomplish this, the node and gateway must be installed in a manner that optimizes the
wireless transmission. The V-Link® -LXRS® operates at a 2.4GHz transmission frequency and
comes standard with a right-angle, ¼- wave rubber whip antenna with an omni-directional
radiation pattern. The antenna has a joint in the middle that allows it to be rotated and aimed.
Using any other antenna than the one that is included with the node will void FCC compliance.
The best method for ensuring optimal radio communication is to conduct an RF survey of the
installation site. This is easily accomplished in Node Commander ® by using the range test
feature to quantify the radio signal strength (RSSI) in various scenarios. See Range Test on
page 33 for instructions on using Node Commander ® for measuring RSSI. The following are
general guidelines for maximizing transmission range:
l

l

l

l
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Establish Line of Sight (LOS) between the node and gateway antennas as best
as possible. Try to avoid obstructions between the antennas, such as buildings,
terrain, vegetation, or other physical barriers. Increase the mounting height of the
node or antenna to allow a clearer LOS path to the gateway. Height above the
ground is also important because reflections off of the ground can interfere at the
receiver. Generally, the higher above the ground the better.
Minimize Radio Frequency Interference (RFI) such as other equipment
antennas, especially those operating in the same frequency range. This includes
other nodes. If other antennas are required nearby, mount them at different
heights to minimize interference. Additionally, the specific node frequency is
selectable within its operational range using the Node Commander® software. Set
the devices to different transmission frequencies.
Minimize Electromagnetic Interference (EMI) such as that which is generated
by power transmission equipment, microwaves, power supplies, and other
electromagnetic sources.
Metal Objects in close proximity to either antenna, particularly ferrous metals
such as steel and iron, can be problematic for wireless communications. The
larger the object, the greater the influence. If mounting the node on metal or near
metal objects in unavoidable, the antenna can be mounted remotely with an
antenna cable. The connector on the antenna is male reverse polarity SMA (male
RPSMA), so a male-to-female RPSMA cable would be required.
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Node Installation

Range Test

After establishing communication between node and gateway, use the range test feature in
Node Commander ® to monitor the signal strength and to optimally position the nodes,
gateway, and antennas for installation. Maximum achievable range is determined by the
gateway and node power settings (found in the device Configure menu) and is highly
dependent on the physical environment surrounding the devices.
1. Right-click on the node header, and select Communicate > Range Test.

Figure 23 - Range Test Menu
2. The total RSSI range for the node and gateway is -90 to 0dBm. The higher
the value (closer to zero), the better, but reliable communication can be
achieved between - 75 dBm and 0 dBm. The devices is still able to
communicate between -90 dBm and -75 dBm, but it could be intermittent or
result in data loss. Position the node and gateway antennas where the best
RSSI value is observed.

Figure 24 - Range Test Statistics
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Connecting Sensors
The V- Link ® - LXRS ® contains an internal, rechargeable
Lithium Polymer (Li-Po) battery. For important precautions
see Safety Information on page 107.

The V- Link ® - LXRS ® is susceptible to damage and/or
disruption of normal operation from Electrostatic Discharge
(ESD). For important precautions see Safety Information on
page 107.

The V-Link ® -LXRS ® wireless sensor node features seven analog input channels that interface
with a wide range of available sensor technologies, essentially converting them into wireless
sensors. The node accommodates Wheatstone Bridge and analog sensors for applications in
wireless strain gauge monitoring, such as torque, force, and pressure measurement, as well as
sensors for other applications like wireless accelerometers, vibration sensors, magnetic field and
displacement sensors. Environmental sensing can be achieved with wireless RTD and wireless
thermocouple monitoring.
The V-Link®-LXRS® includes three channels for single ended sensor measurement, four
channels for differential sensor measurement, and an additional channel dedicated to the onboard internal temperature sensor. Differential channels may need to be factory-set to work for
specific types of sensors. For information about channel configurations see Differential Input
Channels on page 39. For ordering information see Parts and Configurations on page 97.

5.1

Sensor Requirements

Below are guidelines for selecting sensors for use with the V-Link ® -LXRS ® . For interfacing
with sensors outside of these parameters, or not included in the examples in the following
sections, contact Technical Support (see Technical Support on page 95).
Sensor Impedance:
l
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Differential input sensors for a standard V-Link® -LXRS® should have an impedance
of either 350 Ω or 1000 Ω. Sensors that are 120Ω are not recommended. For halfbridge and quarter-bridge configurations, the node impedance value is set to match
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the sensor when the node is manufactured and must be specified at the time of order.
For more information see Parts and Configurations on page 97 . Custom bridge
completion impedance values are available on request.
l

Single ended sensor inputs must have impedance that is less than 5KΩ.

Sensor Signal Voltage:
l

l

Differential sensor inputs include a hardware gain and offset stage before the sensor
input signal is processed by the analog to digital voltage converter within the node.
The combination of the gain, offset, and sensor signal voltage cannot exceed the 0 to
3 V dc input range of the analog to digital converter. For more information see
Differential Input Gain and Offset on page 57.
Single-ended sensor signal voltages can only be positive voltages with respect to the
system ground and must be between 0 and 3 V dc. For single-ended sensor signal
voltages outside of that range see Measuring Voltages over Three Volts on page 45.

Sensor Power:
l

5.2

When using the internal node battery as the node power source, the total current use
for all connected sensors must be less than 50mA. If more current is required, a
higher capacity external power source can be used for the node or the sensor. See
Sensor Power on page 36 for information about sensor power requirement
considerations and options, and see Powering the Node on page 73 for information
regrading node power options.

Wiring Recommendations

In is good practice that all sensor wiring be done with shielded cable. The shield is connected to
the system ground only at one end to avoid ground loops. For sensitive small voltage signals
(such as strain gauges) sensor wire leads should be of matched lengths so the lead resistance
for each connection is as close to the other as possible. For long lengths of wire, a system
calibration is recommended over a sensor calibration. See Sensor Calibration on page 60.
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Sensor Power
When using the internal node battery to power the node, total
sensor current draw of more than 50mA can cause permanent
damage to the node and should be avoided.

Sensors can be powered by the node or with an external power supply. The node sensor
excitation voltage is 3 V dc and can provide up to 50 mA total on all channels. If a higher voltage
or more current is required for the sensor, an appropriately sized external power supply can be
used. For example, using the node battery for current intensive devices such as 4 to 20mA
sensors will drain the battery quickly. For these applications, an external source is
recommended for the sensor or the node. See 0 to 3 V dc Voltage Measurements on page 44
for an example of using an external source for the sensor, and see Powering the Node on page
73 for node power information.
Drain on the battery can also be limited by selecting low resource sampling modes and low duty
sampling rates, which automatically switch the node excitation voltage off after sampling. This
feature can also be utilized to turn switches on and off to further control resource use. See
Using the Excitation Output as a Switch on page 47.
External battery holders and ruggedized outdoor housings that accommodate D cell batteries
are available for the V-Link®-LXRS® and can be used to extend battery operating capacity and
duration. See Node Accessories on page 98.

5.4

Node Channels Designations
Channel

Description

Pin Nomenclature

1
2
3
4
5
6
7
8

differential channel 1
differential channel 2
differential channel 3
differential channel 4
single ended channel 1
single ended channel 2
single ended channel 3
on-board temperature sensor channel

S1
S2
S3
S4
Ain1
Ain2
Ain3
--

Table 1 - Channel Designations
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Terminal Block Connections

When inserting the sensor leads into the terminal block ensure the lead wire is being clamped
under the terminal screw and not the lead insulation. If the sensor wires are a very fine gauge,
folding and tinning them may be useful to provide more area for the terminal screw to make
contact. Failure to provide adequate connection may result in erroneous data.

Node Pin
Number

Signal

Node Pin
Number

Signal

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

SP+
S1+
S1GND
S1 S
SP+
S2+
S2GND
S2 S
SP+
S3+
S3GND
S3 S

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

SP+
S4+
S4GND
S4 S
Ain5
GND
Ain6
GND
Ain7
GND
NC
NC
GND
Vin

Table 3 - Terminal Block Connections
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Pin Descriptions

Signal

Description

Pin
Type

Node external power supply
Vin

An alternate to the node power jack. See
Powering the Node on page 73.
Return

GND
For node power and sensor excitation

+3.6 to +9 V dc
power
input

power
return

Sensor excitation
S+

Power to external sensors. At sampling
rates under 32Hz, it is only active when the
node is sampling the sensors.

output

Positive input to the node programmable
gain amplifier (PGA). Used with Sx-.

Negative input to the node programmable
gain amplifier (PGA). Used with Sx+.
Three wire input

0 to +3 V dc including
gain and offset

Used only for three wire configuration of
quarter bridge strain gauge bridges. Leave
unconnected for non quarter strain gauge
bridge applications.

input

Single ended sensor input
Ainx

NC

Wheatstone Bridge
compatible sensor with
350 Ω or 1000 Ω input
impedance
recommended
0 to +3 V dc

Routed directly to the node analog to digital
(A/D) converter. Return is node GND.

input

Not connected

--

Less than 5 KΩ

“x” denotes the channel number

Table 4 - Node Pin Descriptions
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maximum combined
load on all excitation
pins is 50 mA.

Wheatstone Bridge
compatible sensor with
350 Ω or 1000 Ω input
impedance
recommended

Differential sensor input +

Sx S

return

0 to +3 V dc including
gain and offset
input

Sx-

sufficient current
capacity for sensors

+3 V dc

Differential sensor input +
Sx+

Range

--

V-Link®-LXRS® Wireless Sensor Node User Manual

5.7

Connecting Sensors

Differential Input Channels
NOTE
Differential channels are configured at the time of manufacture with optional
Wheatstone Bridge configurations and impedance values and must be
connected accordingly. For available options see Parts and Configurations on
page 97.

The differential channels provide an input for sensors with a separate analog return. The
measurements are taken with respect to the analog return, instead of the system ground, in
order to provide better protection for small measurements from EMI, RFI, and other sources of
signal noise. The primary use of these channels is for strain gauges, pressure transducers, load
cell,s and other devices that can utilize a Wheatstone Bridge configuration. The V-Link®LXRS ® is available in standard configurations for full, half, or quarter Wheatstone Bridge
operation, at various impedances. See Differential Sensors on page 40. Custom configurations
are also available. For configuration and ordering options see Parts and Configurations on
page 97.
The differential measurement channels provide a +3 V dc excitation voltage to the sensor and
measures the resulting sensor signal output. The sensor signal goes through a programmable
gain amplifier (PGA) and is then processed in the node by a 16 -bit analog to digital (A/D)
converter over the 3 V dc range. The resolution of the sensor measurement is dependent on
the operating range of the sensor. If the application is such that only a small portion of the 3 V
dc range is being utilized, better resolution can be achieved by increasing signal amplification
and by zeroing the sensor baseline in the appropriate offset biasing range.

Figure 25 - Differential Channel Signal Processing
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Differential Sensors

Sensors that are classified as differential sensors often utilize a Wheatstone Bridge
configuration. These sensors are essentially a resistive load that use the bridge
configuration to detect very small resistive changes and produce a precise voltage output as
a result. Some examples include strain gauge elements or strain gauge-based sensors,
such as some load cells and pressure transducers, as well as some soil moisture,
temperature, and other sensors. For use with the V- Link ® - LXRS ® , sensors with an
impedance of 350Ω or 1000Ω are recommended.
Calibration in the Node Commander ® software for these devices varies depending on the
type of sensor and includes using the a calibration wizard for strain gauges. The following
diagrams show how to connect these types of sensors. See Sensor Calibration on page 60
for more information.

Figure 26 - Full Bridge Wiring
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Figure 27 - Half and Quarter-Bridge Wiring

41

Connecting Sensors

V-Link®-LXRS® Wireless Sensor Node User Manual

5.7.2

Connecting Sensors

Measuring Small Voltages

Some sensor types that have small signal voltages (around 20mV or less) may be better
measured by biasing the sensor signal to the mid range of the node input range with a
voltage divider, as shown in Figure 28 - Small Voltage Measurement.
Channel configuration will include adjusting the gain setting accordingly in the Node
Commander® software.

Figure 28 - Small Voltage Measurement
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Single-Ended Input Channels

Single-ended channels are designed to measure voltages with reference to the system ground
and can accommodate many analog sensors types including accelerometers, pressure
transducers, geophones, temperature sensors, inclinometers, and more. These channels can
also be used to measure reference voltages.
Sensors that operate on 3 V dc can be powered with the node excitation voltage. Alternately
sensors can be powered with an external source. For an example of how to connect an
external supply see 0 to 3 V dc Voltage Measurements on page 44.
The single-ended channels can measure signals from 0 to +3 V dc with reference to the system
ground. Sensor output must be positive going voltage in order to operate correctly with the VLink® -LXRS ® . If the sensors output is greater than 3 V dc a voltage divider can be used to
decrease the scale. See Measuring Voltages over Three Volts on page 45. The impedance of
the sensor must be less than 5 KΩ.
The sensor output signal is processed in the node by a 16-bit analog to digital (A/D) converter,
over the 3 V dc range. The resolution of the sensor measurement is dependent on the full scale
output range of the sensor. The closer it is to three volts, the more resolution will be achieved.
The following sections provide examples of how various sensors can be connected to the node.
For other applications or those outside of the operating parameters listed above, contact LORD
MicroStrain® Technical Support (see Technical Support on page 95 for contact information).

Figure 29 - Single Ended Signal Processing

43

V-Link®-LXRS® Wireless Sensor Node User Manual

5.8.1

Connecting Sensors

0 to 3 V dc Voltage Measurements

Sensors that operate in the 0 to 3 V dc range are ideal for the node inputs. Resistive loads
that are not differentially measured, such as string potentiometers, are easily measured by
the node single-ended channels. Power is provided by the node excitation voltage and
measured on a single-ended input, as shown below.
Reference power supply signals between 0 and 3 V dc can be measured by connecting
directly between the signal input pin (Ainx) and ground (GND).
Sensors that have voltage requirements outside of the range of the node excitation voltage
can be powered externally with another source. The sensor output can still be connected
directly to the node input as long as it is between 0 and 3 V dc. For sensor outputs over 3 V
dc see Measuring Voltages over Three Volts on page 45.

Figure 30 - 0 to 3 V dc Measurements
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Measuring Voltages over Three Volts

Voltages over three volts can be measured with the use of a voltage divider circuit. This may
be necessary if a sensor is powered from an external source. The same circuit can also be
used to measure reference power supplies over +3 V dc.
The value of the voltage divider resistors will need to be determined, as required for the
application. A 10KΩ resistor is recommended for the input to the node channel, leaving only
one resistor to calculate.
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Measuring Small Currents (4 to 20mA Sensors)

Sensors with small currents, such as 4 to 20mA sensors, can be used with the nodes by
adding a precision sampling resistor across a single-ended input channel to the node. An
example circuit is shown in Figure 31 - Small Current Measurements .
Because the sensor output can be as much as 20mA it is recommended that an external
source be used to power the sensor. When running on the internal node battery, the node
excitation can only supply 50mA to all sensors, so 20mA would be a significant portion and
would drain the battery quickly. For battery life and current draw information see Using the
Internal Node Battery on page 75. The current limitations can be mitigated by using an
external power source for the sensor or the node. If using node excitation power is the best
for the application, drain on the battery life can be limited by only switching the node
excitation voltage on just before sampling and then turning it off afterward. This happens
automatically at low duty sampling rates (32Hz or lower) and can be set up for other sample
rates with external circuitry. For more information see Using the Excitation Output as a
Switch on page 47.

Figure 31 - Small Current Measurements
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Using the Excitation Output as a Switch

At low sampling rates (under 32Hz) the node automatically switches the excitation voltage
output off when the sensor is not being sampled, in order to conserve battery life. This feature
can also be used in applications where a switch is desired, such as for turning sensor power on
and off when the sensor is powered by the node but has a large current draw. It can also be
used as a general purpose switch, such as for controlling a relay or transistor. The same
limitations apply as to a sensor; the device must operate on 3 V dc and not require more than
50mA when combined with all other sensor current draw. To use the excitation output in this
way, connect the control line of the device (example: relay coil or NPN transistor base) to the
excitation pin on the node terminal block (SP+) and reference (example: other side of the relay
coil or the NPN transistor emitter) to the node ground pin (GND).

5.10

Thermocouples

Thermocouples can be used on the differential input channels by simply adding a highimpedance resistor to the input. An example circuit is shown in Figure 32 - Connecting a
Thermocouple.
Thermocouples should be calibrated by first selecting the appropriate baseline offset range,
output range, or gain and then applying know loads and calculating the slope and offset values.
Using water as the known load medium (submerging the thermocouple in ice and hot water
baths) is a simple method that can be used for calibration.

Figure 32 - Connecting a Thermocouple
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Connecting Accelerometers

LORD MicroStrain ® bridge type accelerometers, such as the Triaxial Accelerometer Cubes,
can be used with V-Link® -LXRS® to create wireless acceleration sensor platforms. Connect
each accelerometer axis output to a node differential input channel. Power is provided to the
accelerometer from the node excitation supply.
For additional information on LORD MicroStrain® accelerometers compatible for use with the
V-Link ® -LXRS ® , see Recommended Sensors on page 99 . For information on integrating
other types of sensors not described in this manual, contact Technical Support (see Technical
Support on page 95).

5.12

On-board Temperature Sensor
l

l

l

l
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The V-Link® -LXRS ® has an on-board, solid state temperature sensor mounted on
the surface of the circuit board.
The temperature sensor output is connected to channel 8of the V-Link®-LXRS®
The temperature sensor has a measurement range of -25˚C to +70˚C range with an
accuracy of ± 0.5˚C @25˚C.
The sensor is made by Texas Instruments (part number LM60). Specifications may
be found on the manufacturer’s website.
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Sensor Settings

LORD MicroStrain ® sensor nodes are designed to accept many sensor types The node
configuration interface settings for measurement units, gain settings, and conversion values. For
more information see Sensor Calibration on page 60. There are preset measurement units, as
well as a user-defined field. Because the wireless sensor system is digital, the analog voltage
readings from the sensors are converted into a digital equivalent value based on the volt-to-bit
scale of the internal analog-to-digital voltage converter (A/D converter). Sensor readings can be
displayed and recorded in volts and A/D value (bits) directly or further converted to engineering
units by applying conversion values and a conversion formula. For more information see Sensor
Conversion Values on page 52, and for instruction of adjusting units see Measurement Units on
page 51.
Some sensors require calibration to determine more accurate conversion values. Calibration
incorporates coefficients that normalize the sensor output to a known reference device and
guarantee accuracy of conversions.
External sensors can be attached to any channel that is suitable for sensor type. Table 5 - Example
External Sensor Types, describes example sensors, units, and calibration options.

channel type

example
external sensors

units
strain

strain gauges in full, half,
quarter/custom Wheatstone
Bridge configurations

volts
A/D value
custom

analog
differential
input

other Wheatstone Bridge
sensors such as:
some pressure sensors
some force sensors
some mass sensors
some displacement sensors
some accelerometers
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calibration
options
calibration
wizard
user entry from
manufacturer
data, lab or field
calibration

g-force
A/D value
volts
custom
English and metric
measurements for;
mass, pressure,
force, distance, and

user entry from
manufacturer
data, lab or field
calibration
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example
external sensors

units

calibration
options

some temperature sensors
temperature.
4-20mA sensors
analog
single ended
input

sensors with voltage outputs
referenced to the system
ground.

volts
A/D value
custom
temperature

thermocouple

thermocouples

A/D value
custom

Table 5 - Example External Sensor Types

50

user entry from
manufacturer
data, lab or field
calibration
user entry from
manufacturer
data, lab or field
calibration
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Measurement Units

Sensor measurement units are set in the channel Configuration menu.
1. To enter the Configuration menu, right-click on the Node heading, and select Configure >
Configure Node. The Channels tab displays channel options available for the current node.

Figure 33 - Channel Configuration Menu
2. Select the type of measurement from the Class menu, and then select Units.

Figure 34 - Select Sensor Units
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Sensor Conversion Values

The conversion values include the slope, offset, gain, scale, and formula for converting the
sensor A/D value (bits) to engineering units. The bits are the digital representation of the
sensor voltage output. The type of sensor, channel, and desired engineering units
determine what conversion values are available. The conversion values are entered
through Node Commander® and saved in the node memory for the applicable channel.
Conversion values for the V-Link ®-LXRS ® are determined mathematically from the sensor
sensitivity specifications, from the sensor manufacturer calibration data, or through a
calibration process. Calibration incorporates coefficients that normalize the sensor output to
a known reference device in order guarantee accuracy of the sensor readings, especially
when making small or precise measurements. See Sensor Calibration on page 60 for more
information. Not all sensors require calibration
The conversion values can be entered in two menus. The channel Configuration menu has
more options than the Calibration Coefficients menu, but both are acceptable ways to enter
the values and formulas.

Figure 35 - Abbreviated Conversion Values Menu
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Figure 36 - Advanced Conversion Values Menu
NOTE
In order to report accurate readings, many sensors require calibration.
Calibration coefficients normalize the sensor output to a known reference
device and are often expressed in the measurement unit conversion values; the
only difference being the use of a traceable reference. Calibration can be used
to account for the variations between individual sensors, wiring, system
electronics, sensor mounting and environmental conditions.

The conversion formula assumes a linear relationship between the original units (such as
volts or A/D bits) and new engineering units (such as strain ), and it is expressed
mathematically as y=mx+b , where y is the engineering units at a given point
(measurement), m is the slope of the line that represents the linear ratio, x is the original unit
value at a given point, and b is a unit conversion offset (in the case of unit conversions) or the
fixed zero load offset of the sensor (in the case of measurement calibration coefficients).
Negative values may be entered for any coefficient.
Slope: is the linear scaling slope coefficient. The slope is the ratio of original units to new
engineering units (EU), and it is used to convert the sensor measurements. The slope
conversion value will vary depending on the engineering units desired. For example if the
original unit is A/D values (bits), and the desired engineering units are acceleration in g-
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force, the slope conversion would describe how many bits equal one unit of g-force (bits/g).
Mathematically, the slope is m in the formula y = mx +b.
Offset: is the linear scaling offset coefficient, and it is typically the starting output value of the
sensor with no load applied (in the original units). Mathematically, the offset is b in y = mx +b.
Input Range (Gain): This sets the amplification of the signal within the node and is only
available for channels with differential inputs and gain amplifiers.
Offset Scale (with Auto Balance): This feature is only available for channels with
differential inputs, and assigns the position and value of the no load measurement of the
sensor. The offset scale level adjusts the operating window of the sensor measurements in
reference to the entire range. For example, in mid scale the sensor no load measurement
will be placed in the middle of the range, providing 50% of the range for positive readings
and 50% of the range for negative readings. Once the scale level is selected, the Auto
Balance procedure is used to assign the actual sensor no- load measurement to the
designated scale.
l

Low is for positive-going signals (zero at 25% of total range).

l

High is for negative-going signals (zero at 75% of total range).

l

Midscale is for positive and negative-going signals (zero at 50% of range).

Figure 37 - Offset Scale Setting
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Calculating a Linear Slope

A data analysis tool such as Microsoft Excel can be used determine the slope of a linear
relationship between sensor output A/D value (bits) and engineering units. This is not a
calibration unless a calibrated reference device is used to measure the applied loads. For
information and examples for determining calibrations coefficients see Sensor Calibration
on page 60 .
Here is an example, using Excel:
1. Open a blank spreadsheet.
2. Enter the A/D value (bits) measurements and applied load in the desired engineering
units in two columns. Enter A/D value in the left column (x-axis value) and the applied
load in the right (y-axis value).
3. From the Insert menu, select Chart > Scatter. Select the preferred format.

Figure 38 - Generate a Scatter Chart
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4. Right-click on the graphed line, and select Add Trendline .
5. Designate the line as Linear, and check the option to Display the Equation on the
chart (Figure 39 - Plot Trendline).

Figure 39 - Plot Trendline
6. The formula of the line is y=mx+b, where y is the engineering units at a given point
(measurement), m is the slope of the line that represents the linear ratio, x is the A/D
value at a given point, and b is the fixed zero load offset of the sensor. Enter the slope
and offset as the conversion values for the sensor channel under the applicable
engineering units. In this example, enter 0.1338 for the slope and -282.36 for the
offset for the units conversion values on the measured channel.

Figure 40 - Slope and Offset Values
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Differential Input Gain and Offset

The combination of the gain, offset, and sensor signal cannot exceed the 0 to 3 V dc input of
the analog to digital converter within the node. See Example Gain and Offset Calculations
on page 59.
Resolution: Applying gain to the sensor signal can be used to maximize the
measurement resolution. The more of the range that is used, the more digital counts are
available to measure the signal, which typically means higher resolution measurements.
Limitations to the gain adjustment are the sensor's measurement capabilities and the 0 to
3V input range of the node. The signal produced after gain is applied to the sensor at full
scale must not exceed the input range of the node.
Offset Scale:The scale setting positions the no-load measurement of the connected
sensor within the 0 to 3V range of the node input. The range of A/D counts that
corresponds with the 0 to 3V node input depends on the resolution of the node. For
example, a 12-bit node will have a full scale bit range of 4096 and a 16-bit node will have
a full scale bit range of 65535. A mid-range setting positions the baseline offset in the
middle of the range (1.5 V or full scale bits*1/2) and is used for sensors with negative and
positive going signals. The low-range setting positions the baseline offset in the bottom
quarter range (750 mV or full scale bits*1/4) and is used for sensors with mostly positive
going signals. The high-range setting positions the baseline offset in the top quarter of
the range (2.25 V or full scale bits *3/4) and is used for mostly negative going signals.

Figure 41 - Differential Input Resolution and Offset (16-bit Node)
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Table 6 - Differential Gain Value lists the gain settings available on the V-Link ® -LXRS ®
differential input channels. The scaled input range is the approximate signal range of a sensor
that would work with that gain, without considering the offset setting.

Gain

Scaled input range

21
30
75
147
291
569
1214
2222
3799
13074

+/- 70mV
+/- 50mV
+/- 20mV
+/- 10mV
+/- 5mV
+/- 2.5mV
+/- 1mV
+/- 100uV
+/- 100uV
+/- 100uV

Table 6 - Differential Gain Value
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Example Gain and Offset Calculations

EXAMPLE 1:
Sensor signal range: 0 to 50 mV
Gain setting: 21
Baseline offset range setting: Mid-range
Calculations:
50 mV * 21 = 1.05 V (maximum voltage of sensor signal with gain)
1.05 V + 1.5 V = 2.55 V ( maximum input voltage to node with gain and offset)
Calculated node input over sensor range: 1.5 to 2.55 V
This is a good setting because the node input voltage is within the 0 to 3 V range.

EXAMPLE 2:
Sensor signal range: 0 to 50 mV
Gain setting: 30
Baseline offset range setting: Low-range
Calculations:
50 mV * 30 = 1.5 V (maximum voltage of sensor signal with gain)
1.5 V + 750 mV = 2.25 V ( maximum input voltage to node with gain and offset)
Calculated node input over sensor range: 750 mV to 2.25 V
This may be a better setting than in Example 1 because the gain is higher, which could increase the
resolution of the measurement. The node input voltage is still within the 0 to 3 V range.

EXAMPLE 3:
Sensor signal range: 0 to 50 mV
Gain setting: 75
Baseline offset range setting: Low-range
Calculations:
50 mV * 75 = 3.75 V (maximum voltage of sensor signal with gain)
3.75 V + 750 mV = 4.5 V ( maximum input voltage to node with gain and offset)
Calculated node input over sensor range: 750 mV to 4.5 V
This setting will not work because the node input voltage is outside of the 0 to 3 V range.
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Sensor Calibration

Many sensors require calibration coefficients to accurately report measurements. Methods for
determining the calibration coefficients depend on the type of sensor measurement and
application. The Node Commander ® software facilitates multiple calibration methods.
Calibration calculators for some applications are also available by contacting LORD
MicroStrain® Technical Support. See Technical Support on page 95.
l

l

Sensor manufacturer’s specifications or calibration: The slope and offset
values, or the data to derive them, are provided with the sensor by the manufacturer
to prove its accuracy and describe expected voltage output. Some sensors are
calibrated individually, while others are manufactured to a standard sensitivity value
(plus or minus some tolerance), which is provided in the device specifications.
Sensor lab calibration: If the manufacturer's calibration is not available or
outdated, calibration of the sensor can be performed with calibrated equipment in a
controlled environment. The calibration equipment and process will typically be
traceable to an industry standard, such as NIST or ASTM in the United States. Fixed
loads are applied to the sensor while the sensor output is recorded. The load is
applied or measured by a calibrated reference device. The known load value from the
calibrated device is then plotted against the measured output of the sensor to
determine the calibration slope and offset. In Node Commander ® this can be
accomplished by taking sensor readings while applying the known loads.

Sensor wiring, tolerances in system electronics, and differences in mounting techniques are
examples of systemic variables that can influence the sensor readings. Sensors that are
making small measurements or are otherwise sensitive to these slight differences may benefit
from a system calibration. The following techniques are system calibrations:
l
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System shunt calibration (internal and external): This option is only available for
Wheatstone bridge-type sensors (such as strain gauges) and utilizes a calibration
wizard in Node Commander®. In the shunt calibration process, an internal or external
precision resistor is used to load part of the sensor bridge while the sensor remains
unloaded. The bridge output is measured and used as a loaded calibration point for
the sensor. In addition to the no-load value it can be used to derive the calibration
slope and offset. The internal shunt resistor is suitable for most applications, however
an external shunt may be beneficial in high gain scenarios.
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System field calibration: The field calibration is a similar methodology to the
sensor lab calibration. Known loads are applied to the sensor while the sensor output
is recorded. The load is applied or measured by a reference device. In this scenario,
the sensor may be installed in final field configuration, and the load may be applied
with the actual stimulus that the sensor will be monitoring. The known load value from
the reference device is then plotted against the measured output of the sensor to
determine the calibration slope and offset. In Node Commander ® this can be
accomplished by taking sensors readings while applying the known loads.
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EXAMPLE: Lab or Field Calibration

The lab and field calibrations use similar methodology. See Sensor Calibration on page 60.
The primary difference is the traceability and calibration environment. Lab calibrations are
performed in controlled environments with traceable equipment and procedures. Field
calibrations are more improvised, although calibrated equipment can still be used to improve
accuracy.
NODE:V-Link® -LXRS® ,16 bit (65535 A/D values)
CHANNEL TYPE: differential analog input, 0 to 3 V dc input range
SENSOR TYPE: load cell
SENSOR PARAMETERS: application voltage range: +/-20 mV
This is the expected output voltage of the sensor based on the range of force being
measured in the application and the sensitivity of the sensor (V/engineering units)
DESIRED OUTPUT: engineering units (EU), force (lbs)
PROCEDURE:
1. Open Node Commander®, and establish communication with the gateway and node
(see System Operational Overview on page 12).
2. Right-click on the node heading and select Configure > Configure Node. Select the
check-box for Channel 1, which is where the strain gauge is connected, and then
select the Configure button.

Figure 42 - Node Configuration Menu
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3. Use the following settings (Figure 43 - Channel Settings):
a. Conversion Coefficients, Class: A/D value
b. Conversion Coefficients, Units: bits
c. PGA Settings, Input Range: +/-20mV (expected sensor range)
d. PGA Setting: Midscale (for positive and negative going signals)
4. Select the Auto Balance button to tare the no-load value of the strain gauge. Click OK
to apply the node settings and exit configuration.

Figure 43 - Channel Settings
5. Right-click on the node heading, and then Sample > Stream > Start.

Figure 44 - Start Node Streaming

63

V-Link®-LXRS® Wireless Sensor Node User Manual

Sensor Settings

6. The streaming graph shows the bit output of the channel.
7. Using a calibrated tool (or some other way of applying and measuring a known load)
and apply loads to the sensor at a number of intervals over the expected range of use.
At each of the calibration intervals, record the applied force and the corresponding
sweep value on the y–axis of the graph (the A/D value output of the sensor).
a. Zoom in and out on the graph by un-checking the Auto Y-Axis Zoom box,
and then right clicking on the graph and selecting Zoom In. Draw a box
around the desired area to zoom in on.
b. Adjust the Y-Axis Width from the field next to the Y-Axis Zoom.
c. End sampling by clicking the red X box on the Streaming Graph tab.

Figure 45 - Node Sampling

64

V-Link®-LXRS® Wireless Sensor Node User Manual

Sensor Settings

8. After making all measurements, calculate a slope from the data using the formula
y=mx+b in a data analysis program, such as Microsoft Excel. See Calculating a
Linear Slope on page 55.
9. Return to the Node Configuration screen for the sensor channel, and select the
Conversion Coefficients Class and Units, and enter the Slope and Offset values
derived in the data analysis program.

Figure 46 - Enter Calibration Values
10. Save the values, and exit configuration. This is the end of a lab calibration.
11. For field calibrations, bbegin node data streaming again with no load on the sensor.
12. Observe the value in the stream graph. If the stream is not at zero, return to the
channel configuration menu, and adjust the offset by increasing or decreasing the
value.
13. Once the offset has been zeroed, verify the calibration by applying known loads on
the sensor throughout the load range, observing and verifying the measurement in
engineering units.
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EXAMPLE: Manufacturer Calibration

NODE: V-Link® -LXRS® ,16 bit (65535 A/D values)
CHANNEL TYPE: differential analog input, 0 to 3 V dc input range
SENSOR TYPE: pressure transducer, voltage output, positive going
SENSOR PARAMETERS:
From the manufacturer calibration sheet included with the sensor;
sensor range: 0-250 psi
sensor zero load output: 0.0032 V dc
sensor full scale output (FSO) with 10V excitation: 86.07 mV
From the application parameters;
sensor excitation in application: 3V supply from the node
DESIRED OUTPUT: engineering units (EU), psi
CALCULATIONS:
Because the sensor will be powered from the node with 3 V, and the sensor manufacturer
calibrated it a 10V, the manufacturer full scale output (FSO) value needs to be scaled to 3V.
(3 V/10 V) * 86.07 mV = 25.82 mV
Select a gain and offset scale value appropriate for the sensor. Because the signal is
positive going in this example application, the low offset scale will provide the largest range.
With the low offset selected, the effective input range of the node is 750 mV to 3 V (2.25 V)
(see Differential Input Gain and Offset on page 57). Calculate the highest gain possible by
dividing the actual input range by the sensor FSO.
2.25 V/25.82 mV = 87
The closest gain setting below optimal gain for a V-Link® -LXRS® is 75 (+/-20 mV). Using a
higher gain value would exceed the input voltage capacity of the node when the sensor is at
higher pressures. This selection makes sense because the approximate input range
designation for a gain of 75 is +/-20 mV (a 40 mV delta minus 10 mV for the low offset),
which is close to the FSO range of the sensor.
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Multiply the sensor FSO by the gain setting to get the sensor voltage after amplification.
75 * 25.8 2 mV = 1.9365 V
Scale the (gained) sensor input voltage/EU ratio to the node input voltage/EU ratio to
determine the equivalent node FSO value (x).
1.9365 V/250 psi=3 V/x
(250 psi * 3 V)/1.9365 V = x = 387. 3 psi
The node converts voltage inputs to A/D values. For a 16-bit node, there are 65536 A/D
values over the 3 V input range. Divide the node EU FSO by the A/D value to get the ratio,
or slope, of EU to A/D value.
387.3 psi/65536 bits = 0.00591 = slope
Once the slope is entered, the sensor offset value can be measured in a data sampling
session, such as streaming. Sample the sensor channel with no load applied, and read the
EU value. Enter this as a negative value for the offset in order to have it subtracted from
readings.
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EXAMPLE: Internal Shunt Calibration

NODE: V-Link® -LXRS® ,16 bit (65535 A/D values)
CHANNEL TYPE: differential analog input, 0 to 3 V dc input range
SENSOR TYPE: strain gauge, Wheatstone Bridge, full bridge configuration
SENSOR PARAMETERS: application voltage range: +/-2 mV
This is the expected output voltage of the strain gauge based on the range of strain being
measured in the application and the sensitivity of the gauge (volts/strain).
DESIRED OUTPUT: engineering units, microstrain
PROCEDURE:
1. Open Node Commander®, and establish communication with the gateway and node.
(See System Operational Overview on page 12.)
2. Right-click on the node name, and select Configure > Configure Node.
3. Select the check-box for Channel 1, which is where the strain gauge is connected,
and then select the Configure button.

Figure 47 - Node Configuration Menu
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4. Use the following settings;
a. Conversion Coefficients, Class: Strain
b. Conversion Coefficients, Units: uStrain
c. PGA Settings, Input Range: +/-2.5 mV (expected sensor range)
d. PGA Setting: Midscale (for positive and negative going signals)
5. Select the Auto Balance button to tare the no-load value of the strain gauge. Observe
the value returned for the Auto Balance value.

Figure 48 - Channel Settings
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6. Select the Strain Wizard.
7. Select the appropriate Bridge Type and click Next.
8. Select Use the Strain Measurement Wizard and click Next.
9. Set the following parameters:
a. Number of Active Gauges: number of a strain elements connected (for
example: 4 for a full-bridge, and 2 for a half-bridge)
b. Gauge Factor: ratio of mechanical strain to electrical output (a gauge
specification).
c. Gauge Resistance: Enter the strain gauge ohm value (a gauge
specification).
d. Shunt Resistance: 499000 ohms

Figure 49 - Strain Wizard Settings
NOTE
Touching sensors and test boards or charging the node battery while acquiring
data may induce noise on sensitive sensor signals and is not recommended.
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10. Select Calibrate.
11. Verify the calibration looks as shown in Figure 50 - Strain Gauge Calibration. The
green line represents the output of the strain gauge. With no load applied it should sit
near the Auto Balance baseline value, represented by the red dashed line. During
calibration, a shunt resistance (selected on the Parameters page) is applied across
the strain bridge, shown by the square pulse on the output. The Offset value, shown
with the dashed blue line, is the average output value of the pulse and should sit
across the top of the pulse. If the gauge has not had to time to equilibrate before
sampling, or if varying environmental factors exist, spikes in the gauge output may
occur and affect the Baseline and Offset values. If this occurs, the Offset and
Baseline values can be adjusted to clip the spikes in the output values. Adjust them
as needed, and select Accept when completed.

Figure 50 - Strain Gauge Calibration
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12. Select Finish to end the Strain Wizard. Note the slope and offset values have been
calculated automatically.

Figure 51 - Completed Strain Wizard
13. Select OK to exit the Channel Configuration window.
14. In the Node Configuration window, select Apply to write the configuration and
calibration values to the node.
15. Select OK to exit.

Figure 52 - Apply Node Settings
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Powering the Node
Apply only the input voltage range specified for the node in the
polarity indicated. Failure to do so could result in personal
injury and permanent damage to the node ( see Safety
Information on page 107).

The node can be powered with either the internal battery or an external source. These sources
cannot be used simultaneously; there is switch on the node to select which source to use. When
the node is manufactured, the switch is set to operate using the internal battery.
External battery holders and a ruggedized outdoor housing that accommodates two D cell
batteries are also available for the V-Link® -LXRS ® and can be used to extend battery operating
capacity and duration. For more information see Node Accessories on page 98.

7.1

Selecting the Power Source
The V- Link ® - LXRS ® contains an internal, rechargeable
Lithium Polymer (Li-Po) battery. For important precautions
see Safety Information on page 107.

The V- Link ® - LXRS ® is susceptible to damage and/or
disruption of normal operation from Electrostatic Discharge
(ESD). For important precautions see Safety Information on
page 107.

The electronics within the node are sensitive to moisture and
static. Do not touch the internal circuitry or expose to liquids.
Verify the node power switch is OFF and the power supply
disconnected before servicing.
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There is user-accessible switch inside of the node to select the power source.
1. Verify the node power switch is in the OFF position and no external power is applied.
2. Remove the node cover screws with a 0.05” hex head wrench.
3. Use a small flat-head screwdriver to push the recessed switch fully to the desired
position, as indicated in Figure 53 - Power Source Selection. The figure shows the
node configured for an external power source.
4. Once the setting is selected, fasten the node cover back in place.

Figure 53 - Power Source Selection
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Using the Internal Node Battery
The V- Link ® - LXRS ® contains an internal, rechargeable
Lithium Polymer (Li-Po) battery. For important precautions
see Safety Information on page 107.

When the internal node switch is set for internal power, the node is powered by a rechargeable,
650 mAH lithium polymer battery. This battery is not user-serviceable.
Node battery life is highly dependent on the number and type of sensors connected, as well as
operational parameters such as sample mode and rate. More active channels and higher
sample rates equate to decreased battery life. The following graph shows an example
approximation of the battery life for a V- Link ® - LXRS ® with different strain gauge sensor
configurations over a range of sample rates operating in Synchronized Sampling mode. For
additional V-Link®-LXRS® power specifications see Power Profile on page 105.
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Charging the Node Battery
Use only the power supply specified for the node to charge
the battery. Using a power supply above the rated voltage
could cause personal injury and permanent damage to the
node. For important safety considerations see Safety
Information on page 107.

NOTE
Touching sensors and test boards or charging the node battery while acquiring
data may induce noise on sensitive sensor signals and is not recommended.

1. Turn the node power switch off, and plug the node power supply into the node and
then into a 120/240VAC, 50/60Hz AC power source. Use only the power supply
specified for the node. Use the supplied power plug adapters, as needed.
2. Verify the charge indicator is red and on brightly, indicating charging. If it is only on
dimly a battery fault has occurred. Reset the node by unplugging power and then
plugging it back in. The indicator should now turn on brightly. Continue charging until
the indicator turns green to indicate a completed charge. Charging takes
approximately 6-8 hours from a full depletion.

Figure 54 - Node Charging
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Connecting an External Power Supply
Apply only the input voltage range specified for the node in the
polarity indicated. Failure to do so could result in personal
injury and permanent damage to the node ( see Safety
Information on page 107).

When the internal node switch is set for external power, the node may be directly powered by
the power supply specified for charging the node (or another regulated AC to DC power supply
with the appropriate output parameters, see Operating Specifications on page 103). It can also
be powered by an external battery or other regulated DC supply. The supply must deliver a
stable voltage between 3.2 and 9.0 V dc and be capable of sourcing at least 100 mA. Power
supplies over 9 V dc, such as vehicle batteries, can be used by installing a step-down regulator
(for V-Link ® - LXRS ® power use specifications see Power Profile on page 105 ). External
battery holders and ruggedized outdoor housings that accommodate D cell batteries are
available for the V-Link®-LXRS® (see Node Accessories on page 98).
External power is applied through either the power supply jack, or the terminal block
connectors. Do not connect both. Observe connection polarities, or the node may be
damaged.

Figure 55 - External Power Connections
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Possible cause and recommended solution
1.1 node or gateway power is off

1. POWER
gateway or node does
not turn on, or node
does not charge

The status indicator LED on the device may be off. Turn the
device on, and the status indicator LED should illuminate.
1.2 external power is off or miswired
Verify the device power source is connected correctly and
powered on.
1.3 wrong power supply
Using a power supply other than the one specified for the device
(or an external supply that is outside of the device operating
range) could result in permanent damage to the device or cause
it to not work properly.
1.4 node internal source select switch is incorrect
When the node is manufactured, it is set to internal battery
operation, but it can be configured to accept an external source.
When set to accommodate an external source, the battery
cannot be charged.
1.5 node battery is dead
If the node power source selector is set to internal, and the node
will not power on or charge, the node battery may need to be
replaced. Contact LORD MicroStrain ® Technical Support (See
Technical Support on page 95).
1.6 node battery fault
If the battery charge indicator on the node is only dimly
illuminated when charging is attempted, a battery fault condition
has occurred. Unplug power, and then plug it back in. The
indicator should turn on brightly, indicating charging.
1.7 sensors are drawing too much current
The node battery can only supply a limited amount of power to
the connected sensors. If an over-current condition occurs, the
node will shut down. Consider powering the node or sensors
with an external source.
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Possible cause and recommended solution
1.8 node or gateway is damaged
If all power settings and connections have been verified, and the
node is still unresponsive, contact LORD MicroStrain ®
Technical Support (See Technical Support on page 95).
2.1 node or gateway has no power

2. COMMUNICATION
no communication to
the gateway or node

Verify the node and gateway have power applied and that
applicable power switches are on. Power is indicated on both
devices by a status indicator LED.
2.2 gateway has no communication with the computer
Verify gateway communication in the software. Check, remove,
and reconnect communications and power cables as applicable.
l

l

l

For serial gateways, verify that the COM port setting.
For USB gateways, verify that the drivers are installed on the
computer (included with Node Commander®) and that the
software has had sufficient time to detect it.
For Ethernet gateways, use Live Connect™ to verify
communications on a DHCP network. Check that the
extended timeouts are enabled in the Node Commander®
Edit > Preferences menu, under Devices. Once
communication has been established, the network
configuration can be changed.

2.3 node cannot be configured
Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling or sleeping, it cannot be configured. In Node
Commander ® , execute the Stop Node command to put the
node in idle state, allowing configuration to occur.
If the user inactivity timeout is set very low, the configuration
menu will have to be entered quickly, before the timeout occurs,
putting the node back in a sample or sleep state.
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2.4 node is out of range
Perform a bench test with the node in close proximity to the
gateway to verify they are operational. For range test and
installation recommendations see Range Test on page 33. The
system has been tested to operate with the node and gateway
up to 2 km apart with clear line of sight.
2.5 node is not in normal boot mode
If the node status indicator shows the node booting in a mode
other than the normal boot mode, it can be bypassed by toggling
the node ON/OFF switch rapidly three times, then leaving it in
the ON position for normal power up. In normal boot mode the
communication can be established with automatic node
discovery (or manually) once the boot process is complete and
the node is in idle state. Start-up mode can then be changed in
the software.
2.6 node is sampling
Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling, it cannot be configured. In Node Commander ® ,
execute the Stop Node command to put the node in idle state,
allowing configuration to occur.
2.7 node is sleeping
Observe the node status indicator LED to determine what state
it is: boot, idle, sample, or sleep. If the node is sleeping, it cannot
be configured. In Node Commander ® , execute the Stop Node
command to put the node in idle state, allowing configuration to
occur.
2.8 gateway or node is damaged
Verify all connections, power, and settings. If available, try
installing alternate nodes and gateways one at a time to see if
the faulty device can be identified. If no conclusion can be
determined or to send a device in for repair, contact LORD
MicroStrain ® Technical Support ( See Technical Support on
page 95).
3.1 no communication to node or gateway

81

V-Link®-LXRS® Wireless Sensor Node User Manual

Troubleshooting

Problem

Possible cause and recommended solution

3. DATA ACQUISITION

Verify connections and power to the node and gateway. Verify
they are powered on and communicating with the software.
Enter a configuration menu to verify that the node can be
accessed.

sensor data is missing
or incorrect

3.2 sampling settings are incorrect
If the sampling mode, rate, or duration are not performing as
expected, enter the node configuration menu, and verify the
sampling settings.
3.3 sampling has not started
If sampling is occurring, the sampling mode will be displayed
next to the node name in Node Commander®. The node device
status indicator will also be flashing the sampling mode code. If
the node is not sampling, activate it in the software or with a
sample on start up boot sequence.
3.4 sensor is not connected correctly
Verify sensors connections and wiring. For non- standard
connections contact LORD MicroStrain ® Technical Support
(See Technical Support on page 95).
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Device Status Indicators

The following is a complete summary of the V-Link®-LXRS® status indicators.

Indicator

Behavior
OFF

Battery Charge
Status Indicator

ON bright red
ON dim red
ON green
OFF
OFF, with occasional flash
Ten rapid flashes green when
power is initially applied
1 second pulse green
Continuously ON green
1 Hz pulse green

Device Status
Indicator

1 Hz pulse blue
ON bright blue

Pulses for each ping
Four to seven slow pulses
when power is initially applied

Node Status
Node battery is not currently
being charged
Node battery is charging
Battery fault condition, reset by
unplugging power and then
plugging it back in
Battery is fully charged
Node is OFF or sleeping
Node is sleeping with radio check
intervals enabled (default is every
5 seconds)
Node is booting normally and
sending out a status message.
Node is idle
Node is logging or streaming data
Node is sampling in low duty cycle
Node is in synchronized sampling
mode
Node is in synchronized sampling
mode and is re-syncing or taking a
burst sample
Node is sending out
communication requests (such as
in ping command, range test, or
EEPROM read/write)
Fault condition

Table 7 - Device Status Indicators
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Using the Node Tester Board

The node tester board is used to verify node and network functions before sensors are
connected, or for diagnostic purposes. The node tester board is used only on differential input
channels, and provides a fixed load so system functions can be verified including basic
operations not related to the sensor, such as communication and sampling. A fixed load is
applied to the differential input by pressing the load button.
There are various impedance value node tester boards available, depending on the node it is
being used with. See Parts and Configurations on page 97 for configuration options and part
numbers. Each is configurable to emulate full, half and quarter bridge strain gauges. Table 8 Tester Board Configuration describes the strain gauge load settings available. This setting
must match the type of node channel that is being tested. For example if the node is a quarterbridge node, the setting on the tester board must be the same. The configuration chart is also
printed on the underside of the board.

NOTE
The switches may come with a protective film covering them. Simply peel the
film off to access the switches.

Configuration

SW 1
position

SW 2
position

SW 3
position

SW 4
position

Full Bridge
Half Bridge
Quarter Bridge

ON
OFF
OFF

ON
OFF
OFF

ON
ON
OFF

OFF
OFF
ON

Table 8 - Tester Board Configuration
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The following steps describe an example of how to use the tester board to sequence through
the primary functions of the node and the wireless system. If the results indicated in the final
steps are achieved, the system is fully operational for measuring a full bridge strain gauge.
Other scenarios can be tested as needed.
1. Set the jumpers for Full Bridge operation, using a small flat head screw driver to fully
push the switch into the desired position.
2. Verify the node is powered off and unplugged. If installed, remove the node terminal
blocks from the node.
3. Plug the node tester board into the node Channel 1 position.

Figure 56 - Node Tester Board Installation
4. If not already completed, set up the Wireless Sensor Network equipment and install
the Node Commander® software. See System Operational Overview on page 12.
5. Launch theNode Commander ® software, and establish communications with the
gateway and node.
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6. Enter the node channel configuration menu by right-clicking on the node heading in
Node Commander ® and selecting Configure > Configure Node, and then the
Channels tab.

Figure 57 - Node Configuration Menu

7. Select the check box for Channel 1, which is where the Node Tester Board is
installed, and then select Configure.

Figure 58 - Node Channel Configuration
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8. Use the following settings for the node tester board.
a. Conversion Coefficients, Units: uStrain
b. Conversion Coefficients, Class: Strain
c. PGA Settings, Input Range: +/-2.5mV
d. PGA Setting: Midscale
9. Select the Auto Balance button to tare the no load value of the tester board.

Figure 59 - Channel Settings
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10. Select the Strain Wizard.
11. Select Full Bridge for the Bridge Type and click Next.
12. Select Use the Strain Measurement Wizard, and click Next.
13. Set the following for the Node Tester Board
a. Number of Active Gauges: 4
b. Gauge Factor: 2
c. Gauge Resistance: Enter the node tester board ohm value.
d. Shunt Resistance: 499000 ohms

Figure 60 - Strain Wizard Settings
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14. Select Calibrate.
15. Verify the calibration looks as shown in Figure 61 - Strain Gauge Calibration. The
green line represents the output of the strain gauge. With no load applied it should sit
near the Auto Balance baseline value, as shown, and is represented by the red
dashed line. During calibration, a shunt resistance (selecting on the Parameters
page) is applied across the strain bridge, shown by the square pulse on the output.
The Offset value, shown with the dashed blue line, is the average output value of the
pulse and should sit across the top of the pulse. If the gauge has not had to time to
equilibrate before sampling, or varying environmental factors exist, spikes in the
gauge output may occur and affect the Baseline and Offset values. If this occurs, the
Offset and Baseline values can be adjusted to clip the spikes in the output values.
Adjust them as needed, and select Accept when completed.

Figure 61 - Strain Gauge Calibration
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16. Select Finish to end the Strain Wizard. Note that the slope and offset values have
been calculated.

Figure 62 - Completed Strain Wizard
17. Select OK to exit the channel Configuration window.
18. In the Node Configuration window, select the Streaming tab. Uncheck Continuous
Streaming, and set the Time Duration to 15 seconds.
19. Select Apply to write configuration and calibration values to the node. Select OK to
exit.

NOTE
Touching sensors and test boards or charging the node battery while acquiring
data may induce noise on sensitive sensor signals and is not recommended.

NOTE
There are many sampling options available in the Node Commander ®
software. The following describes just one option, for illustrative purposes.
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20. Right-click on the Node heading and then select Sample > Stream > Start.
21. As soon as Start is selected, the node will start collecting data for a duration of 15
seconds. During that time, press and release the load button on the node tester
board to shunt the resistive load on and off. Verify the result is as shown in the figure
below. The pulse value should equal tester board ohm value. Testing is complete.

Figure 63 - Node Sampling Menu

Figure 64 - Node Tester Output Stream
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Updating Node Firmware

Under the recommendation of LORD MicroStrain ® Technical Support Engineers, nodes can
be upgraded to the latest available firmware to take advantage of new features or correct
operating issues. Node Commander ® version 2.7.0 or greater can be used to update any
mXRS® or LXRS® node or gateway firmware to the most current version. Updates are found
on the LORD MicroStrain ® website. See Technical Support on page 95 for contact and
website information.
1. Download the LXRS® Firmware Upgrade file from the LORD MicroStrain® website.
2. Once downloaded, extract the contents of the .zip file into a folder on the computer.
Verify there is a file with a .zhex extension.
3. Launch Node Commander ® , and establish communication between the node and
gateway as normal.
4. While holding F1 button on the keyboard, right-click the node name, and a drop-down
menu will appear.

Figure 65 - Update Node Firmware
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5. Release the F1 key.
6. Click Upgrade Firmware, and the Node Firmware Upgrade window will appear.
7. Click Browse, and navigate to the downloaded .zhex file.
8. Click Write, and the upgrade sequence will begin. When completed, "Upgrade
Success" will appear in the Status column.

Figure 66 - Upgrade Firmware Window
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Repair and Calibration

The V-Link®-LXRS® has no components which require factory calibration and certification.
General Instructions
In order to return any LORD MicroStrain ® product, you must contact LORD
MicroStrain ® Sales or Technical Support to obtain a Return Merchandise
Authorization number (RMA). All returned merchandise must be in the original
packaging including manuals, accessories, cables, etc. with the RMA number
clearly printed on the outside of the package. Removable batteries should be
removed and packaged in separate protective wrapping. Please provide the
LORD MicroStrain ® model number and serial number as well as your name,
organization, shipping address, telephone number, and email. Normal turnaround for RMA items is seven days from receipt of item by LORD
MicroStrain®.
Warranty Repairs
LORD MicroStrain ® warrants its products to be free from defective material
and workmanship for a period of one (1) year from the original date of
purchase. LORD MicroStrain ® will repair or replace, at its discretion, a
defective product if returned to LORD MicroStrain® within the warranty period.
This warranty does not extend to any LORD MicroStrain® products which have
been subject to misuse, alteration, neglect, accident, incorrect wiring, misprogramming, or use in violation of operating instructions furnished by us. It
also does not extend to any units altered or repaired for warranty defect by
anyone other than LORD MicroStrain®.
Non-Warranty Repairs
All non- warranty repairs/replacements include a minimum charge. If the
repair/replacement charge exceeds the minimum, LORD MicroStrain ® will
contact the customer for approval to proceed beyond the minimum with the
repair/replacement.
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Technical Support

There are many resources for product support found on the LORD MicroStrain ® website,
including technical notes, FAQs, and product manuals.
http://www.microstrain.com/support_overview.aspx

For further assistance our technical support engineers are available to help with technical and
applications questions.

Technical Support
sensing_support@LORD.com
Phone: 802-862-6629
Fax: 802-863-4093
SKYPE: microstrain.wireless.support
Live Chat is available from the website during business hours:
9:00 AM to 5:00 PM (Eastern Time US & Canada)
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Maintenance

Maintenance

There are no user-serviceable parts on the V-Link®-LXRS®. For device service and repair contact
LORD MicroStrain ® Technical Support (see Technical Support on page 95). Opening the device
will void the product warranty.
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Parts and Configurations

Parts and Configurations

10.1

Standard Nodes

For the most current product information, custom, and OEM options not listed below, refer to
the LORD MicroStrain® website or contact the LORD MicroStrain® Sales Department.

Model Number

V-LINK -LXRS-M

Description
l

Four differential channels

l

Three single ended channels

l

Internal temperature sensor

LORD
MicroStrain®
Part Number

6312-1000

Configuration Options (Required for use. Specify at time of order)
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l

Full-bridge configuration on one or more differential channels.

l

350Ω or 1000Ω half-bridge completion on one or more differential channels.

l

350Ω or 1000Ω quarter-bridge completion on one or more differential channels.

l

High g-force option. Node operates in gravitational forces in excess of 550 g.
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Node Accessories

The following parts are available for use with the V-Link®-LXRS®. For the most current product
information, custom, and OEM options not listed below, refer to the LORD MicroStrain ®
website or contact the LORD MicroStrain® Sales Department. See Product Ordering on page
101.

Description
Charging power supply for V-Link®-LXRS® with international
plug adapters
IP66/NEMA4 rated rugged outdoor enclosure
for V-Link®-LXRS® with two D cell battery capacity
Magnetic mounting strips for outdoor enclosure
350Ω node tester board
1000Ω node tester board
Inductive remote power starter for nodes
D cell battery tray for use with wireless nodes (indoor use)
AA cell battery tray for use with wireless nodes (indoor use)
Lithium D cell battery 19 Ah capacity
Lithium AA cell battery 2 Ah capacity
Standard whip antenna (FCC compliant)
Replacement terminal blocks

Table 9 - Node Accessories
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LORD MicroStrain®
Part Number
6313-6010
6313-3100
6302-4000
6313-9000
6313-8000
6303-0300
6302-0200
6302-0300
6302-0000
6302-0100
9010-0048
9008-0272
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Recommended Sensors

Many sensors can be used with the V-Link ®-LXRS® . The following are sensors manufactured
by LORD MicroStrain ® and are supported for use with the V-Link ® -LXRS ® . For help with
other sensor applications contact Technical Support (see Technical Support on page 95).

Model
ACCEL TRIAX-50
ACCEL-TRIAX-100
ACCEL-TRIAX-200
ACCEL-TRIAX-500
3DM-GX3-15
3DM-GX3-25
3DM-GX3-35
3DM-GX3-45

Description

LORD MicroStrain®
Part Number

Triaxial Accelerometer, +/-50g
Triaxial Accelerometer, +/-100g
Triaxial Accelerometer, +/-200g
Triaxial Accelerometer, +/-500g
Inertial Measurement Unit
Attitude Heading and Reference System
Attitude Heading and Reference System
GPS Aided Inertial Navigation System

6402-0310
6402-0110
6402-0210
6402-0410
6227-xxxx (various)
6223-xxxx (various)
6225-xxxx (various)
6228-xxxx (various)

Table 10 - LORD MicroStrain® Sensors
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Wireless System Equipment

The following system parts are available for use with the V-Link®-LXRS®. For the most current
standard, custom, and OEM product options, refer to the LORD MicroStrain ® website or
contact the LORD MicroStrain® Sales Department. See Product Ordering on page 101.

Model

Description

WSDA-1500-SK
--

Ethernet Data Gateway Starter Kit
Node Commander® Software
SensorCloud™ Software Subscription
(contact LORD MicroStrain® Sales)
USB Gateway Starter Kit
RS232 Gateway Starter Kit.
Analog Gateway Starter Kit
Replacement USB cable
USB Gateway cable extender
Replacement serial cable
Ethernet Data Gateway
USB Gateway
RS232 Serial Output Gateway
Analog Output Gateway
Wireless Accelerometer Node
Wireless Accelerometer Node
Wireless 2-Channel Analog Input Sensor Node
Wireless 2-Channel Analog Input Sensor Node
Ruggedized Wireless Analog Sensor Input Node
Wireless Thermocouple Node
Wireless Displacement Sensor Node
Wireless Environmental Sensor Node
Wireless Energy Monitoring Sensor Node
Wireless RTD Sensor Node
Wireless IEPE Accelerometer Node

-WSDA-BASE-104-SK
WSDA-BASE-102-SK
WSDA-BASE-101-SK
---WSDA-1500
WSDA-BASE-104
WSDA-BASE-102
WSDA-BASE-101
G-Link-LXRS
G-Link2-LXRS
SG-Link-LXRS
SG-Link-OEM
SG-Link-RGD
TC-Link-LXRS
DVRT-Link-LXRS
ENV-Link-Pro
Watt-Link-LXRS
RTD-Link-LXRS
IEPE-Link -LXRS

Table 11 - Wireless System Equipment
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LORD
MicroStrain®
Part Number
6314-1501
6301-0300
-6307-1041
6307-1021
6307-1011
9022-0029
6307-0900
4005-0005
6314-1500
6307-1040
6307-1020
6307-1010
various models
various models
various models
various models
various models
various models
various models
various models
various models
various models
various models
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Product Ordering

Products can be ordered directly from the LORD MicroStrain ® website by navigating to the
product page and using the Buy feature.
http://www.microstrain.com/wireless
For further assistance, our sales team is available to help with product selection, ordering
options, and questions.

Sales Support
sensing_sales@LORD.com
Phone: 802-862-6629
Fax: 802-863-4093

9:00 AM to 5:00 PM (Eastern Time US & Canada)
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11.

Specifications

11.1

Physical Specifications

Dimensions:
Weight:
Enclosure Environmental Rating:
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Specifications

79 mm x 96 mm x 20 mm
141 grams
General purpose indoor
(IP67/NEMA4X rated enclosure available)
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11.2

Operating Specifications

Parameter

Specifications
General

Sensor input channels

Differential analog, 4 channels
Single-ended analog, 3 channels

Integrated sensors

Internal temperature, 1 channel

Options

Half and 1/4 bridge, 350 Ω or 1000 Ω completion on any or all
channels, custom gain, custom anti-aliasing filter, extended
operating temperature, g-force, and environmental packaging,
low RF radiated power

Data storage capacity

4 M bytes (up to 2,000,000 data points, data type dependent)
Analog Input Channels

Measurement range

Differential: full-bridge, ≥ 350 Ω (factory configurable)
Single-ended: 0 to 3 V dc

Accuracy

± 0.1% full scale typical

Resolution

16 bit

Anti-aliasing filter bandwidth

Single-pole Butterworth
-3 dB cutoff @ 250 Hz (factory configurable)

Bridge excitation voltage

+ 3 V dc, 50 mA total for all channels
(pulsed @ sample rates ≤ 16 Hz to conserve power)

Measurement gain and offset

User-selectable in software on differential channels,
gain values from 21 to 13074
Integrated Temperature Channel

Measurement range

-40 °C to 85 °C

Accuracy

± 2 °C (at 25 °C) typical

Resolution

16 bit

Sampling modes

Synchronized, low duty cycle, datalogging, event-triggered

Sampling rates

Continuous sampling: 1 sample/hour to 512 Hz
Periodic burst sampling: 32 Hz to 10 KHz
Datalogging: 32 Hz to 10 KHz

Sample rate stability

±3 ppm

Network capacity

Up to 2000 nodes per RF channel (and per gateway) depending
on the number of active channels and sampling settings.
Refer to the system bandwidth calculator:
http://www.microstrain.com/configure-your-system

Synchronization between nodes

± 32 μsec

Event driven monitoring

User-definable threshold trigger (synchronized and low duty
cycle modes), 200K bytes pre- event recording

Sampling

Operating Parameters
Wireless communication range

Outdoor/line-of-sight: 2 km( ideal) *, 800 m (typical)**
Indoor/obstructions: 50 m (typical)**

Radio frequency (RF)
transceiver carrier

2.405 to 2.470 GHz direct sequence spread spectrum over 14
channels, license free worldwide, radiated power programmable
from 0 dBm (1 mW) to 16 dBm (39 mW); low power option
available for use outside the U.S.- limited to 10dBm (10mW)

RF communication protocol

IEEE 802.15.4

RF data downloading

9 minutes to download full memory

Power source

Internal: 3.7 V dc, 650 mAh Lithium ion rechargeable battery
External: +3.2 to +9.0 V dc

Power consumption

See power profile :
http://files.microstrain.com/V-Link-LXRS-Power-Profile.pdf

Operating temperature

-20 ˚C to + 60 ˚C (extended temperature range available with
custom battery/enclosure, -40 ˚C to + 85 ˚C electronics only)

Status LED’s

battery charging, battery charged, node activity

Acceleration limit

500 g standard (high g option available)
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Specifications
Physical Specifications

Dimensions

74 mm x 79 mm x 21 mm

Weight

141 grams

Environmental rating

Indoor use (IP65/66 enclosures available)

Enclosure material

Anodized aluminum

Compatible gateways

All WSDA® base stations and gateways

Compatible sensors

Bridge type analog sensors, 0 to 3 V dc analog sensors

Connectors

Screw terminal block

Shunt calibration

Internal shunt calibration resistor 499 KΩ, differential channels

Software

SensorCloud™, SensorConnect™, Node Commander® ,
Windows XP/Vista/7

Software development kit (SDK)

Data communications protocol available with EEPROM maps
and sample code (OS and computing platform independent)
http://www.microstrain.com/wireless/sdk

Regulatory compliance

FCC (U.S.), IC (Canada), CE, ROHS

Integration

*Measured with antennas elevated, no obstructions, and no RF interferers.
**Actual range varies depending on conditions such as obstructions, RF interference, antenna height, & antenna orientation.
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Specifications

Power Profile

Node power use is highly dependent on the number and type of sensors connected and
operational parameters such as sample mode and rate. More active channels and higher
sample rates equate to increased power use. Below is an example approximation of the power
use of a V- Link ® -LXRS ® with different strain gauge sensor configurations over a range of
sample rates operating in Synchronized Sampling mode. This chart can be used to
approximate external node power source requirements. For V-Link ®-LXRS ® internal battery
life specifications see Using the Internal Node Battery on page 75.

Figure 67 - Example V-Link®-LXRS® Power Profile
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Radio Specifications

The V-Link®-LXRS® Wireless Sensor Node employs a 2.4GHz IEEE 802.15.4 compliant radio
transceiver for wireless communication. The radio is a direct-sequence spread spectrum radio
and can be configured to operate on 14 separate frequencies ranging from 2.405 GHz to 2.470
GHz. Following the 802.15.4 standard, these frequencies are aliased as channels 11 through
24. For all newly manufactured nodes, the default setting is 2.425 GHz (channel 15).
For standard models, radiated transmit power is programmable from 0 dBm (1 mW) to 16 dBm
(39 mW). A low-transmit power option is available (for use in Europe and elsewhere) and is
limited to 10 dBm (10 mW).
The radio complies with FCC Part 15 (USA) and IC (Canada) regulations. The radio is licensefree worldwide. Using antennas and transmission equipment other than what is provided may
void FCC compliance.

NOTE
l

l
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The gateway can automatically manage nodes operating on different frequencies
by using the Node Discovery feature in Node Commander ® . In this routine, the
gateway listens for node broadcasts on the frequency channel to which it is set. If
the node is in normal boot-up mode, it will provide the broadcast when it is initially
powered-on, and it will broadcast on all channels. As long as the node is poweredon after activating the Node Discovery feature, the gateway will link to it and
remember the channel setting for future node queries.
Manually matching the node and gateway frequency channels is required in some
applications. For example, when sending broadcast messages from the gateway to
multiple nodes (including the synchronized sampling beacon) all nodes must be on
the same channel as the gateway in order to receive the broadcast. Assigning
channels is also a good idea when multiple gateways are attached to one host
computer or when other wireless equipment is nearby and frequency or
transmission interference may occur.
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Safety Information

Safety Information

This section provides a summary of general safety precautions that must be understood and
applied during operation and maintenance of components in the LORD MicroStrain ® Wireless
Sensor Network. Throughout the manual, ANSI Z535 standard safety symbols are used to
indicate a process or component that requires cautionary measures.

12.1

Battery Hazards

The V- Link ® - LXRS ® contains an internal, rechargeable
Lithium Polymer battery. Lithium Polymer batteries are a fire
and explosion hazard. Do not store or operate the node at
temperatures above 212°F (100°C). Do not disassemble,
short circuit, crush, puncture, or otherwise misuse the battery.
When recharging the node internal battery, use only the
power supply specified for node charging, and follow the
instructions. See Charging the Node Battery on page 76 .
Applying a voltage above the input range may result in
dangerous battery conditions and cause permanent damage
to the node.
Lithium Polymer batteries contain toxic chemicals that are
harmful to humans and the environment. Disposal is subject
to federal and local laws. Do not discard the battery or the
node in the trash. Follow proper battery disposal protocol, or
contact LORD MicroStrain ® Technical Support for
information on extracting the battery or returning the product
for proper recycling and disposal.

107

V-Link®-LXRS® Wireless Sensor Node User Manual

12.2

Safety Information

User Configurable Power Settings

The V-Link®-LXRS® Wireless Sensor Node can be powered by either the internal battery or an
external source. There is user-accessible switch to select the source. The default setting for
this switch is for internal battery operation and charging. See Selecting the Power Source on
page 73.

Connecting an external power source when the node is set to
internal power could result in injury or permanent node
damage. For details on how to adjust the switch setting see
Connecting an External Power Supply on page 77.

l

l

l
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If the node is set to use an external source, and the charging power supply is plugged
in, it will power the node from the power supply and not charge the battery. It will
continue to use the internal battery.
If the node is set to internal, and an external power supply other than the one used for
charging is plugged in, several things could happen. If it is a power supply that is in
the operating range of the charging circuit, it may charge the battery. If it is below the
range of the charging circuit, nothing will happen. If the applied voltage is above the
range of the charging circuit, damage to the node will likely occur and personal injury
may result.
When under battery operation there is a limit to how much current the node can
provide to sensors. If the node is in an over-current condition it will shut off until the
cause is removed. Using an external power source for the node or sensor can
mitigate this issue.
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Power Supply

The V-Link®-LXRS® Wireless Sensor Node can be powered by an external source.

Apply only the input voltage range specified for the V-Link®LXRS ®. Connect to a power source that is near the device,
is accessible, and adheres to all national wiring standards.
Compliance with wiring standards is assumed in the
installation of the power source and includes protection
against excessive currents, short circuits, and ground faults.
Failure to do so could result in personal injury and
permanent damage to the device. For details on how to
connect the power supply see Connecting an External
Power Supply on page 77.

12.4

ESD Sensitivity

The V- Link ® - LXRS ® is susceptible to damage and/or disruption of normal operation from
Electrostatic Discharge (ESD), particularly during data acquisition.

ESD damage can occur when the device is touched,
especially at the device interfaces such as the antenna and
connectors. Use proper grounding techniques when
handling. If an ESD event occurs, and operation has been
interrupted, reset the device by cycling power to it and/or
restarting the operational mode in the system software.
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Safety Information

Disposal and Recycling

The V-Link® -LXRS® contains internal batteries, printed
circuit boards, and electronic components. These items
are known to contain toxic chemicals and heavy metals
that are harmful to humans health and the environment.
Disposal is subject to federal and local laws. Do not
discard the device or batteries in the trash. Follow proper
electronic and battery waste disposal protocol, as
dictated by federal and local authorities. Some states
also have programs for extracting reusable parts for
recycling.
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References

References

13.1

Reference Information

Many references are available on the LORD MicroStrain ® website including product user
manuals, technical notes, and quick start guides. These documents are continuously updated,
and new applications are added. They may provide more accurate information than printed or
file copies.

Document

Where to find it

Online Wireless Network Calculator

http://www.microstrain.com/configure-yoursystem

Node Commander® Software User
Manual
SensorCloud™
Overview
MathEngine® Overview
LORD MicroStrain® Wireless Sensors
Network Software Development Kit
Product Datasheets
Product Manuals and Technical Notes
Product Application Notes
NIST Calibration Procedures
ASTM Testing Procedures

http://www.microstrain.com/support/docs
http://www.sensorcloud.com/systemoverview
http://www.sensorcloud.com/mathengine
http://www.microstrain.com/wireless/sdk
http://www.microstrain.com/wireless/sensors
http://www.microstrain.com/support/docs
http://www.microstrain.com/applications
http://www.nist.gov/calibrations/
http://www.astm.org/Standard/standardsand-publications.html

Table 12 - Related Documents
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References

Glossary

These terms are in common use throughout the manual:
A/D Value: the digital representation of the analog voltages in an analog- to- digital (A/D)
conversion. The accuracy of the conversion is dependent on the resolution of the system
electronics; higher resolution produces a more accurate conversion. Also referred to as "bits".
ASTM: The Association of Standards and Testing is a nationally-accepted organization for the
testing and calibration of technological devices.
Base Station: The base station is the transceiver that attaches to the host computer and
provides communication between the software and the node(s). It is also referred to as a
“gateway”.
Bits: the digital equivalent of voltage on the node. See 'A/D Value'.
Burst Sampling: a mode of operation in which the node is sampled for a fixed window of time
(burst), and then repeats that window at set intervals. The burst duration and time between
bursts is configurable. Same as periodic burst sampling.
Calibration: to standardize a measurement by determining the deviation standard and
applying a correction (or calibration) factor
Configuration: a general term applied to the node indicating how it is set up for data
acquisition. It includes settings such as sampling mode and rate, number of active channels,
channel measurement settings, offsets, hardware gain, and calibration values.
Continuous Sampling: a mode of operation in which the node is sampled continuously until
stopped, or continuously for a fixed amount of time.
Coordinated Universal Time (UTC): the primary time standard for world clocks and time. It
is similar to Greenwich Mean Time (GMT).
Cycle Power: a command transmitted to the node to reboot it, either through a hardware or
software switch
Data Acquisition: the process of collecting data from sensors and other devices
Data Logging: the process of saving acquired data to the system memory, either locally on
the node or remotely on the host computer

112

V-Link®-LXRS® Wireless Sensor Node User Manual

References

DHCP (network): Dynamic Host Configuration Protocol is the standardized networking
protocol used on Internet Protocol (IP) networks, which automatically configures devices that
are attached to it by assigning and configuring the device IP address.
Differential (signal): is a method of transmitting electrical signals in which they are paired
together as a differential pair and measured with reference to each other only. This method
makes the pair less susceptible to electrical noise.
EMI: Electromagnetic Interference is an inductive or radiated disturbance that can create
signal degradation on electrical signals, including loss of data.
ESD: Electrostatic Discharge is the sudden flow of electricity that can occur between two
charged objects of different potential that come in contact or in close proximity of each other.
Static electricity is a common source of ESD.
Event-Based Sampling: a mode of operation in which the node sampling is started when a
sensor measurement value (threshold) is achieved.
Firmware: the code that is programmed onto a microcontroller or similar device in an
embedded system. It includes device operation commands, conditions, memory allocation, and
many other tasks.
Gateway: The gateway is a transceiver that attaches to the host computer and provides
communication between the software and the node(s). It is also known as a “base station”.
Host (computer): The host computer is the computer that orchestrates command and control
of the attached devices or networks.
LED: Light Emitting Diode is an indicator light that is used in electronic equipment.
LOS (Line of Sight): is used in radio communications to describe the ideal condition between
transmitting and receiving antennas in a radio network. As stated, it means the antennas are in
view of each other with no obstructions.
LXRS® :Lossless Extended Range Synchronized is the proprietary LORD MicroStrain ® data
communications protocol used in the wireless sensor network.
NIST: The National Institute of Standards and Testing is a nationally-accepted organization for
testing and calibration of technological devices.
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Node: The node is the wireless transceiver that the sensor (s) is connected to, providing
communication with the gateway. The G-Link ® -LXRS ® , V-Link ® -LXRS ®, and SG-Link ® LXRS® are examples of nodes manufactured by LORD MicroStrain®.
Node Tester board: The Node Tester board is a device designed by LORD MicroStrain® that
can be plugged into nodes to test their functionality.
Offset: When describing a mathematically-linear relationship, the offset is the value where the
line that represents the relationship in a graph crosses the y-axis. The equation of a straight
line is: y = mx+b, where x is the x-axis coordinate, y is the y-axis coordinate, m is the slope and
b is the offset.
Oversampling: In signal processing, oversampling is a technique used to achieve increased
signal resolution and better noise immunity by recording readings at a higher frequency than
the output of the device being measured. In analog- to- digital conversion, the higher the
oversampling rate, the better the recreated analog signal.
Packet: unit of sampled data
Periodic Burst Sampling: a mode of operation in which the node is sampled for a fixed
window of time (burst), and then repeats that window at set intervals. The burst duration and
time between bursts is configurable. Same as burst sampling.
Ping: a byte transmitted by the gateway to the node. The node responds by echoing the byte,
indicating communication exists between the node and gateway.
PGA: A Programmable Gain Amplifier is an electronic device used to amplify small electrical
signals.
Range Test: a continuous string of pings used to validate communication between the
gateway and the node over distance and obstruction
Read/Write EEPROM: commands transmitted to the node to read or write parameters stored
in the node’s operating system
Real Time Clock (RTC): a computer clock that keeps track of the current time
Resolution: in digital systems, the resolution is the number of bits or values available to
represent analog values or information. For example, a 12- bit system has 4,096 bits of
resolution and a 16-bit system has 65,536 bits.
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RFI: Radio Frequency Interference is a disturbance in an electrical circuit due to
electromagnetic induction or radiation.
RSSI: Received Signal Strength Indication is a measurement of the transmission power in a
radio signal. It is measured in decibels with reference to 1 milliWatt (dBm).
RS232: a serial data communications protocol
Sensor: a device that physically or chemically reacts to environmental forces and conditions,
producing a predictable electrical signal
Sleep: a command transmitted to the node to put it into sleep configuration
Sampling: the process of taking measurements from a sensor or device
Sampling Mode: the type of sampling that is being utilized, such as event- triggered,
continuous, or periodic. The nodes have several sampling modes that employ these types of
sampling.
Sampling Rate: the frequency of sampling
Single Ended: electrical signals that are measured with reference to a system ground
Slope: When describing a mathematically linear relationship, the slope is the steepness of the
line that represents that relationship on a graph. The equation of a straight line is: y = mx+b,
where x is the x-axis coordinate, y is the y-axis coordinate, m is the slope, and b is the offset.
Streaming: Streaming is a sampling mode in which all active channels (and the sensors
attached to them) are measured, and the acquired data is transmitted to the gateway and
software. The data is not written to non- volatile memory during streaming. Streaming can
either be finite (have a user defined start and end time) or continuous (continued until the power
is cycled on the node).
Synchronized Sampling: a sampling mode that automatically coordinates all incoming node
data to a particular gateway. This mode is designed to ensure data arrival and sequence.
Transmission rate: the number of data packets per transmission window, measured in
seconds. Depending on the sampling mode and settings it will be between 1 and 64
packets/second.
Transmission window: the time allowed for one data transmission at the automatically
determined transmission rate
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USB: Universal Serial Bus, a serial data communications protocol
Wheatstone Bridge: an electrical circuit used to measure unknown electrical resistances
WSN: Wireless Sensor Network describes a distribution of sensors and data acquisition
equipment that autonomously monitors environmental characteristics, such as temperature,
pressure, and strain.
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